Add-on Module

RF-ALUMINIUM

Ultimate and Serviceability Limit State Design and Stability Analysis according to Eurocode 9

Program Description

All rights, including those of translations, are reserved.

No portion of this book may be reproduced – mechanically, electronically, or by any other means, including photocopying – without written permission of Dlubal Software GmbH.

© Dlubal Software GmbH
Am Zellweg 2 D-93464 Tiefenbach
Tel.: +49 9673 9203-0
Fax: +49 9673 9203-51
E-Mail: info@dlubal.com
Web: www.dlubal.com
# Content

<table>
<thead>
<tr>
<th>Content</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>4</td>
</tr>
<tr>
<td>1.1 Add-on Module RF-ALUMINIUM</td>
<td>4</td>
</tr>
<tr>
<td>1.2 RF-ALUMINIUM Team</td>
<td>5</td>
</tr>
<tr>
<td>1.3 Using the Manual</td>
<td>6</td>
</tr>
<tr>
<td>1.4 Opening the RF-ALUMINIUM Module</td>
<td>6</td>
</tr>
<tr>
<td>2. Input Data</td>
<td>8</td>
</tr>
<tr>
<td>2.1 General Data</td>
<td>8</td>
</tr>
<tr>
<td>2.1.1 Ultimate Limit State</td>
<td>10</td>
</tr>
<tr>
<td>2.1.2 Serviceability Limit State</td>
<td>12</td>
</tr>
<tr>
<td>2.1.3 National Annex (NA)</td>
<td>13</td>
</tr>
<tr>
<td>2.2 Materials</td>
<td>14</td>
</tr>
<tr>
<td>2.3 Cross-Sections</td>
<td>16</td>
</tr>
<tr>
<td>2.4 Intermediate Lateral Restraints</td>
<td>21</td>
</tr>
<tr>
<td>2.5 Transverse Welds</td>
<td>22</td>
</tr>
<tr>
<td>2.6 Effective Lengths - Members</td>
<td>24</td>
</tr>
<tr>
<td>2.7 Effective Lengths - Sets of Members</td>
<td>28</td>
</tr>
<tr>
<td>2.8 Nodal Support - Sets of Members</td>
<td>29</td>
</tr>
<tr>
<td>2.9 Member End Releases - Sets of Members</td>
<td>31</td>
</tr>
<tr>
<td>2.10 Serviceability Data</td>
<td>32</td>
</tr>
<tr>
<td>3. Calculation</td>
<td>33</td>
</tr>
<tr>
<td>3.1 Detail Settings</td>
<td>33</td>
</tr>
<tr>
<td>3.1.1 Ultimate Limit State</td>
<td>33</td>
</tr>
<tr>
<td>3.1.2 Stability</td>
<td>35</td>
</tr>
<tr>
<td>3.1.3 Serviceability</td>
<td>38</td>
</tr>
<tr>
<td>3.1.4 Other</td>
<td>39</td>
</tr>
<tr>
<td>3.2 Start Calculation</td>
<td>41</td>
</tr>
<tr>
<td>4. Results</td>
<td>42</td>
</tr>
<tr>
<td>4.1 Design by Load Case</td>
<td>43</td>
</tr>
<tr>
<td>4.2 Design by Cross-Section</td>
<td>44</td>
</tr>
<tr>
<td>4.3 Design by Set of Members</td>
<td>45</td>
</tr>
<tr>
<td>4.4 Design by Member</td>
<td>46</td>
</tr>
<tr>
<td>4.5 Design by x-Location</td>
<td>46</td>
</tr>
<tr>
<td>4.6 Governing Internal Forces by Member</td>
<td>47</td>
</tr>
<tr>
<td>4.7 Governing Internal Forces by Set of Members</td>
<td>48</td>
</tr>
<tr>
<td>4.8 Member Slendernesses</td>
<td>49</td>
</tr>
<tr>
<td>4.9 Parts List by Member</td>
<td>50</td>
</tr>
<tr>
<td>4.10 Parts List by Set of Members</td>
<td>51</td>
</tr>
<tr>
<td>5. Evaluation of Results</td>
<td>52</td>
</tr>
<tr>
<td>5.1 Results on the RFEM model</td>
<td>53</td>
</tr>
<tr>
<td>5.2 Result diagrams</td>
<td>55</td>
</tr>
<tr>
<td>5.3 Filter for Results</td>
<td>56</td>
</tr>
<tr>
<td>6. Printout</td>
<td>58</td>
</tr>
<tr>
<td>6.1 Printout Report</td>
<td>58</td>
</tr>
<tr>
<td>6.2 Graphic Printout</td>
<td>58</td>
</tr>
<tr>
<td>7. General Functions</td>
<td>60</td>
</tr>
<tr>
<td>7.1 Design Cases</td>
<td>60</td>
</tr>
<tr>
<td>7.2 Cross-Section Optimization</td>
<td>62</td>
</tr>
<tr>
<td>7.3 Units and Decimal Places</td>
<td>64</td>
</tr>
<tr>
<td>7.4 Data Exchange</td>
<td>65</td>
</tr>
<tr>
<td>7.4.1 Exporting Materials to RFEM</td>
<td>65</td>
</tr>
<tr>
<td>7.4.2 Exporting Effective Lengths to RFEM</td>
<td>65</td>
</tr>
<tr>
<td>7.4.3 Exporting Results</td>
<td>65</td>
</tr>
<tr>
<td>8. Worked Example: Column Subject to Biaxial Bending</td>
<td>67</td>
</tr>
<tr>
<td>8.1 Design values</td>
<td>67</td>
</tr>
<tr>
<td>8.2 Cross-Section Properties</td>
<td>68</td>
</tr>
<tr>
<td>8.3 Classification</td>
<td>68</td>
</tr>
<tr>
<td>8.4 Effective Cross-Section Properties</td>
<td>71</td>
</tr>
<tr>
<td>8.5 Flexural Buckling About Major Axis (⊥ to y-y)</td>
<td>72</td>
</tr>
<tr>
<td>8.6 Flexural Buckling About Minor Axis (⊥ to z-z)</td>
<td>73</td>
</tr>
<tr>
<td>8.7 Torsional Buckling About Longitudinal Axis (About x-x)</td>
<td>74</td>
</tr>
<tr>
<td>8.8 Torsional-Flexural Buckling</td>
<td>74</td>
</tr>
<tr>
<td>8.9 Bending with Axial Compression</td>
<td>76</td>
</tr>
<tr>
<td>A Literature</td>
<td>80</td>
</tr>
<tr>
<td>B Index</td>
<td>81</td>
</tr>
</tbody>
</table>
1. Introduction

1.1 Add-on Module RF-ALUMINIUM

Eurocode 9 (EN 1999-1-1:2007) provides design rules for aluminium structures in the member states of the EU. The RFEM add-on module RF-ALUMINIUM by DLUBAL is a powerful tool for designing aluminium structures modeled with member elements. Country-specific provisions are considered in the National Annexes. In addition to the parameters given in the program, you can define your own limit values or create new National Annexes.

RF-ALUMINIUM carries out all typical ultimate limit state designs, stability analyses, and the deformation analysis. In the ultimate limit state design, the module considers the action of various internal forces. You have also the option to select one of the interaction checks given in the standard. Dividing cross-sections into the classes 1 through 4 is an important part of the cross-sections selected for design. In this way, the program checks the limit of the resistance and rotational capacity by local buckling of cross-section parts. RF-ALUMINIUM determines the c/t-ratios of the cross-section parts in compression and runs the classification automatically.

In case of member segments connected by weld seams, the softening in the heat-affected zone (HAZ) can be taken into account.

For the stability analyses, you can define for each member or set of members separately, if buckling in y- and/or z-direction is possible. You can also define additional intermediate lateral restraints for realistic modeling. From the boundary conditions, RF-ALUMINIUM determines the slenderness ratios and the elastic critical buckling loads. The elastic critical moment for lateral-torsional buckling necessary for the lateral-torsional buckling check can be determined automatically or specified manually. The point of shear load application is considered, which has a decisive effect on torsion.

The serviceability limit state design is important for slender aluminium sections. For this design, you can assign load cases, load combinations, and result combinations to the various design situations. The limit deformations are preset through the National Annex. If necessary, you can adjust them. Furthermore, you can specify reference lengths and precambers, which will be considered accordingly in the design.

If necessary, the module carries out an optimization of the cross-sections and exports the changed cross-sections to RFEM. Using the design cases, you can analyze separate structural components in complex models or analyze variants.

RF-ALUMINIUM is an add-on module integrated in RFEM. Thus, the design-relevant input data is already preset when you start the module. After the design, you can evaluate the results in the graphical user interface of RFEM. Finally, you can document the analyses in the global printout report of RFEM, from determination of internal forces to design.

We hope you enjoy working with RF-ALUMINIUM.

Your DLUBAL Team
1.2 RF-ALUMINIUM Team

The following people were involved in the development of RF-ALUMINIUM:

**Program coordination**
Dipl.-Ing. Georg Dlubal  
Ing. Ph.D. Martin Čudejko  
Dipl.-Ing. (FH) Younes El Frem

**Programming**
Ing. Zdeněk Kosáček  
Ing. Ph.D. Martin Čudejko  
Dr.-Ing. Jaroslav Lain  
Ing. Martin Budáč

**Cross-section and material library**
Ing. Ph.D. Jan Rybin  
Ing. Jiří Kubiček

**Program design, dialog box figures, and icons**
Dipl.-Ing. Georg Dlubal  
Mga. Robert Kolouch  
Ing. Jan Miléř

**Program testing**
Ing. Martin Vasek  
Dipl.-Ing. (FH) René Flori

**Localization, manual**
Ing. Fabio Borriello  
Ing. Dmitry Bystrov  
Ing. Ph.D. Martin Čudejko  
Eng.º Rafael Duarte  
Ing. Jana Duníková  
Bc. Chelsea Jennings  
Ing. Aleksandra Kociolek  
Ing. Roberto Lombino  
Eng.º Nilton Lopes  
Mgr. Ing. Hana Macková  
Ing. Téc. Ind. José Martínez  
MA Translation Anton Mitleider  
Ing. Petra Pokorná  
Ing. Michaela Prokopová  
Ing. Marcela Svitáková  
Ing. Marcia Wardyn

**Technical support and final testing**
M.Eng. Cosme Asseya  
Dipl.-Ing. (BA) Markus Baumgärtel  
Dipl.-Ing. Moritz Bertram  
Dipl.-Ing. (FH) Steffen Clauß  
Dipl.-Ing. Frank Faulstich  
Dipl.-Ing. (FH) René Flori  
Dipl.-Ing. (FH) Stefan Frenzel  
Dipl.-Ing. (FH) Walter Fröhlich  
Dipl.-Ing. (FH) Wieland Götzler  
Dipl.-Ing. (FH) Bastian Kuhn  
Dipl.-Ing. (FH) Ulrich Lex  
Dipl.-Ing. (BA) Sandy Matula  
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier  
M.Eng. Dipl.-Ing. (FH) Walter Rustler  
M.Sc. Dipl.-Ing. (FH) Frank Sonntag  
Dipl.-Ing. (FH) Christian Stautner  
Dipl.-Ing. (FH) Lukas Sühnel  
Dipl.-Ing. (FH) Robert Vogl
1.3 Using the Manual

Topics like installation, graphical user interface, results evaluation, and printout are described in detail in the manual of the main program RFEM. The present manual focuses on typical features of the RF-ALUMINIUM add-on module.

The descriptions in this manual follow the sequence and structure of the module's input and results windows. In the text, the buttons are given in square brackets, for example [View mode]. At the same time, they are pictured on the left. The Expressions that appear in dialog boxes, windows, and menus are set in italics to clarify the explanations.

At the end of the manual, you find the index. If you still cannot find what you are looking for, please check our website www.dlubal.com, where you can go through the FAQ pages and find a solution by using various filter criteria.

1.4 Opening the RF-ALUMINIUM Module

In RFEM, you have the following possibilities to start the add-on module RF-ALUMINIUM.

Menu

To open the add-on module, you can select in the RFEM menu

Add-on Modules → Design - Aluminium → RF-ALUMINIUM.

Figure 1.1: Menu: Add-on Modules → Design - Aluminium → RF-ALUMINIUM
1 Introduction

**Navigator**

Alternatively, you can start the add-on module in the *Data* navigator by clicking **Add-on Modules → RF-ALUMINIUM**.

![Data navigator: Add-on Modules → RF-ALUMINIUM](image1)

**Panel**

If results from RF-ALUMINIUM are already available in the RFEM model, you can also open the module from the panel.

First, set the relevant RF-ALUMINIUM design case in the load case list of the RFEM toolbar. Then, click the [Show Results] button to graphically display the design criterion on the members.

If the results display is activated, the panel is available, too. Now you can click [RF-ALUMINIUM] in the panel to open the module.

![Panel button (RF-ALUMINIUM)](image2)
2. Input Data

When you start the add-on module, a new window opens. In this window, a navigator is displayed on the left that manages the available input and output windows. The drop-down list above the navigator contains the design cases (see Chapter 7.1, page 60).

The design-relevant data is to be defined in several input windows. When you open RF-ALUMINIUM for the first time, the following parameters are imported automatically:

- Members and sets of members
- Load cases, load combinations, and result combinations
- Materials
- Cross-sections
- Effective lengths
- Internal forces (in the background, if calculated)

To select a window, click the corresponding entry in the navigator. To go to the previous or next input window, use the buttons shown on the left. You can also use the function keys to select the next [F2] or previous [F3] window.

To save the results, click [OK]. Thus, you exit RF-ALUMINIUM and return to the main program. To exit the module without saving the new data, click [Cancel].

2.1 General Data

In the 1.1 General Data window, you select the members, sets of members, and actions that you want to analyze. The tabs manage the load cases, load combinations, and result combinations for the ultimate and serviceability limit state designs.

Figure 2.1: Window 1.1 General Data
Design of

You can design Members as well as Sets of Members. If you want to design only particular objects, clear the All check box. Now you can access the text boxes to enter the numbers of the relevant members or sets of members. To select the list of the numbers preset in the text box, double-click in the box and overwrite the list by manually entering the data. Alternatively, you can select the objects graphically in the RFEM work window upon clicking [\].

When you design a set of members, the program determines the extreme values of all members contained in the set of members and takes into account the boundary conditions of connected members for stability analyses. The corresponding results are shown in the results windows 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List by Set of Members.

To define a new set of members, click [New]. The dialog box already known from RFEM appears where you can specify the parameters for a set of members.

National Annex (NA)

In the upper-right corner, you select the National Annex whose parameters you want to apply for the design and the limit values of the deformation.

To check the parameters of the selected NA and, if necessary, adjust them, click [Edit]. This dialog box is described in Chapter 2.1.3, page 13.

Comment

In this text box, you can type user-defined notes describing, for example, the current design case.
2.1.1 Ultimate Limit State

 existing load cases and combinations

This dialog box section contains all load cases, load combinations, and result combinations created in RFEM.

To transfer the selected entries to the To Design dialog box section, click \[\text{\textless}\]. Alternatively, you can just double-click them. To transfer the entire list to the right, click \[\text{\textless\textless}\].

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common in Windows applications.

If a load case is highlighted in red, for example, LC6 or LC7 in Figure 2.5, this means that it cannot be designed. This happens when the load cases are defined without any load data or the load cases contain only imperfections. When you transfer such a load case, a corresponding warning appears.

At the end of the list, several filter options are available. They will help you assign the entries sorted by load case, load combination, or action category. The buttons have the following functions:

- \[\text{\textbullet}\] Selects all cases in the list.
- \[\text{\textbullet\textbullet}\] Inverts selection of load cases.

Table 2.1: Buttons in the tab Ultimate Limit State
2 Input Data

Design of

The section on the right contains the load cases, load combinations, and result combinations selected for design. To remove selected entries from the list, click [▼] or double-click the entries. To transfer the entire list to the left, click [▼▼].

You can assign the load cases, load combinations, and result combinations to the following design situations:

- Persistent and Transient
- Accidental

This classification controls the partial safety factors γM0, γM1, and γM2 that are included in the determination of the resistances Rd for the cross-section and stability analyses (see Figure 2.9, page 13).

To change the design situation, use the list at the end of the dialog box section. To open the list, click the drop-down arrow [▼].

![Figure 2.6: Assigning design situation](image)

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common in Windows applications.

Designing an enveloping max/min result combination is faster than designing all contained load cases and load combinations. But designing a result combination also has its disadvantages: First, the influence of the contained actions is difficult to discern. Second, for the determination of the elastic critical moment for LTB, Mr, the envelope of the moment distributions is analyzed, from which the most unfavorable distribution (max or min) is taken. However, this distribution only rarely reflects the moment distribution in the individual load combinations. Thus, in the case of an RC design, more unfavorable values for Mr are to be expected, leading to higher design ratios.

Result combinations should be selected only for dynamic combinations. For "normal" combinations, load combinations are recommended, because here the actual moment distributions are taken for the determination of Mr.
2.1.2 Serviceability Limit State

Figure 2.7: Window 1.1 General Data, tab Serviceability Limit State

**Existing Load Cases and Combinations**
This dialog box section contains all load cases, load combinations, and result combinations created in RFEM.

**Design of**
Load cases, load combinations, and result combinations can be added or removed as described in Chapter 2.1.1.

You can assign different deflection limit values to the load cases, load combinations, and result combinations. You can select from the following design situations:

- *Characteristic*
- *Frequent*
- *Quasi-permanent*

To change the design situation, select it in the list at the end of the entry after clicking [▼] (see Figure 2.7).

The deflection limits are defined in the National Annex. To adjust these values for the design situations, click [Nat. Annex] and modify them in the appearing *National Annex Settings* dialog box (see Figure 2.9, page 13).

The 1.10 Serviceability Data window manages the reference lengths governing for the deformation check (see Chapter 2.10, page 32).
2.1.3 National Annex (NA)

In the upper-right list of the 1.1 General Data window, you can select the National Annex whose parameters apply to the design and the limit values of the deformation.

Figure 2.8: Selecting the National Annex

To check and, if necessary, adjust the preset parameters, click [Edit] (see the following figure).

To create a user-defined National Annex, click [New].

Alternatively, you can use the [Nat. Annex] button available in all input windows in order to open the National Annex Settings dialog box.

Figure 2.9: Dialog box National Annex Settings - BS

In the first dialog box sections, you can check and, if necessary, change the Partial Factors Acc. to 6.1.3, and in the section on the left the Serviceability Limits (Deflections) Acc. to 7.2. Furthermore, you can specify the maximum utilization for the General Triaxial State of Stress in Section.
The buttons at the bottom of the dialog box have the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Resets the program’s default settings</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Sets the user-defined settings</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Saves the modified settings as user-defined default settings</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Deletes the user-defined National Annex.</td>
</tr>
</tbody>
</table>

Table 2.2: Buttons in the dialog box National Annex Settings

2.2 Materials

The window is subdivided into two parts. The upper part shows all materials used in RFEM. The Material Properties dialog box section shows the properties of the current material, that is, the table row currently selected in the upper section.

![Image](Figure 2.10: Window 1.2 Materials)

Materials that will not be used for the design appear in grey. Materials that are not allowed appear in red. Changed materials appear in blue.

The material properties required for the determination of internal forces are described in Chapter 4.3 of the RFEM manual (Main Properties). The material properties required for the design are stored in the global material library. These values are preset (Additional Properties).

To adjust the units and decimal places of material properties and stresses, select in the menu Settings → Units and Decimal Places (see Chapter 7.3, page 64).
2 Input Data

Material Description

The materials defined in RFEM are preset but can be changed at any time. To do this, click the material in column A. Then, click \( \text{ץ} \) or press function key \([F7]\) to open the material list.

![List of materials](image)

Figure 2.11: List of materials

According to standard [1], you can select only materials of the "Aluminium" category. Only alloys can be designed that are covered by [1], Table 3.2a, b, and c. For this reason, you cannot edit the material properties in the module. RF-ALUMINIUM checks neither the product form of the material according to [1], Table 3.2b nor the shape of the cross-section.

After you import a material, the design relevant Material Properties are updated.

If you change the material description manually and your entry is stored in the material library, RF-ALUMINIUM will import the material properties, too.

Material Library

Numerous materials are already available in the library. To open it, select in the menu

**Edit → Material Library**

or use the button shown on the left.

![Material Library](image)

Figure 2.12: Dialog box Material Library
In the Filter section, *Aluminium* is preset as the material category. To select an alloy for design, use the *Material to Select* drop-down list. You can check the corresponding properties in the dialog box section below.

To transfer the selected material to Window 1.2 of RF-ALUMINIUM, click [OK] or [· ·].

Chapter 4.3 of the RFEM manual describes how to filter, add, or rearrange materials.

### 2.3 Cross-Sections

This window manages the cross-sections that are used for the design. In addition, you can specify optimization parameters in this window.

**Figure 2.13: Window 1.3 Cross-Section**

**Cross-Section Description**

The cross-sections defined in RFEM are preset together with the assigned material numbers.

To change a cross-section, click the entry in column B, thus selecting this cell. To open the cross-section row of the current text box, click [Cross-Section Library] or [· ·] in the text box or press the function key [F7] (see Figure 2.14).

In this dialog box, you can select a different cross-section or a different cross-section row. To select a different cross-section category, click [Back to cross-section library]. The general cross-section library opens.

Chapter 4.13 of the RFEM manual describes how cross-sections can be selected from the library.
RF-ALUMINIUM performs all necessary designs for the following cross-section types:

- I-sections: rolled/welded, doubly symmetrical or mono-symmetrical about the z-axis
- Hollow and box sections: rolled/welded, square-edged/rectangular, doubly-symmetrical
- Massive cross-sections: circular/rectangular
- Pipes
- Angles: rolled/welded simple sections with equal or unequal legs
- T-sections: rolled/welded, symmetrical about z-axis
- Channel-sections: rolled/welded, symmetrical about y-axis

RF-ALUMINIUM also designs other cross-sections from the library or SHAPE-THIN. For these sections of the "General" type, however, not all design options are available.

You can also enter the new cross-section description in the text box directly. If the data base contains the entry, RF-ALUMINIUM imports the corresponding cross-section properties, too.

A modified cross-section is highlighted in blue.

If cross-sections specified in RF-ALUMINIUM differ from those used in RFEM, both cross-sections are displayed in the graphic on the right. The designs are carried out with the internal forces from RFEM for the cross-section selected in RF-ALUMINIUM.

The welded types of cross-section are parametric sections that are manufactured by welding plates. Note for RF-ALUMINIUM that the design of these weld seams (HAZ effects) is currently not implemented.
2 Input Data

Cross-Section Type for Classification
This column shows the cross-section type used for the classification. According to [1], Clause 6.1.4, the cross-sections can be designed elastically or plastically, depending on the class. Cross-sections that are not completely covered by the provisions of the standard are classified as General (see Figure 2.14). These can be designed only elastically (class 3 or 4).

Max. Design Ratio
This column is displayed only after the calculation. It serves as a decision support for the optimization. By means of the displayed design ratio and colored reference scales, you can see which cross-sections are little utilized and thus oversized, or overstressed and thus undersized.

Optimize
Each cross-section can undergo an optimization process. For the RFEM internal forces, the program searches the cross-section that comes as close as possible to a user-defined maximum design ratio. This ratio can be specified in the General tab of the Details dialog box (see Figure 3.4, page 39).

To optimize a cross-section, open the drop-down list in column D or E and select the relevant entry: From current row or, if available, From favorites ‘Description’. Recommendations for the cross-section optimization can be found in Chapter 7.2, page 62.

Remark
This column shows remarks in the form of footers that are described in detail below the cross-section list.

A warning might appear before the calculation: Incorrect type of cross-section No. XX. This means that there is a cross-section that is not registered in the data base. This can be a user-defined cross-section or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropriate cross-section for design, click [Library] (see description after Figure 2.13).

Member with Tapered Cross-Section
RF-ALUMINIUM does not support the design of tapered members with different cross-sections at both ends of the member. If you try to design them, the following message appears:

Figure 2.15: Message appearing when designing a taper
Info About Cross-Section

In the *Info About Cross-Section* dialog box, you can view the cross-section properties, stress points, and c/t-parts.

The right part of the dialog box graphically presents the currently selected cross-section. The buttons below the graphic have the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides the stress points</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides the c/t-parts</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides the numbers of stress points or c/t-parts</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides details of the stress points or c/t-parts (see Figure 2.17)</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides the dimensions of the cross-section</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays or hides the principal axes of the cross-section</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Resets the full view of the cross-section graphic</td>
</tr>
</tbody>
</table>

Table 2.3: Buttons of the cross-section graphic
To view detailed information on stress points (distances to center of gravity, statical moments of area, normalized warping constants, etc.) and c/t-parts, click [Details].

Figure 2.17: Dialog box Stress Points of TO 80/60/4/4/4/4/K
2.4 Intermediate Lateral Restraints

In Window 1.4, you can define intermediate lateral restraints for members. RF-ALUMINIUM always assumes this kind of support as perpendicular to the minor z-axis of the cross-section (see Figure 2.16). Thus, you can influence the effective lengths of members which are important for the analyses for flexural buckling and torsional-flexural buckling.

In the analysis, intermediate lateral restraints are considered as lateral and torsional restraints.

In the upper part of the window, you can assign up to nine lateral restraints to each member. The Settings section shows the entries in columns as an overview for the member selected above.

To define an intermediate lateral restraint, select the Lateral Restraint check box in column A. To graphically select the member and to activate its row, click [ ]. If you select the check box, the other columns become available for entering the parameters.

In column C, you specify the Number of the intermediate lateral restraints. Depending on the specified number, one or more of the following Intermediate Lateral Restraints columns for the definition of the x-locations are available.

If the Relatively (0 ... 1) check box is selected, the points of support can be defined by relative specification. The locations of the intermediate restraints are determined from the member length and the relative distances from the member start. If the Relatively (0 ... 1) check box is cleared, you can define the distances manually in the upper table.

In case of cantilevers, avoid intermediate restraints because they divide the member into segments: For cantilevered beams, this would result in statically underdetermined segments with lateral and torsional restraint only at one end.
2.5 Transverse Welds

If segments of members are connected by weld seams, you can specify their arrangement and detailing in Window 1.5. In this way, you can take into account the HAZ softening of the cross-section.

The Designers' Guide to Eurocode 9 [3] provides further information on the topic “transverse welds.”

To select a member graphically and show its corresponding row, click \( \text{\textbullet} \).

Changes are possible in the table as well as in the Settings tree.

Transverse Welds

To define a transverse weld, select the check box in column A. Thus, further columns for specifying parameters become available.

Length L

This column shows the corresponding member lengths.

Transverse Welds

Number

Column C allows you to specify the Number of the weld seams. You can specify up to four transverse welds for each member. In the next columns, you then can specify the x-locations.

\( x_1 / x_2 / x_3 / x_4 \)

If the Relatively \((0 \ldots 1)\) check box is selected, you can define the locations of the transverse welds by means of relative input: They result from the member length and the relative distances from the member start. To specify the distances by their length, clear the selection of the Relatively \((0 \ldots 1)\) check box.
2 Input Data

Weld Type
In this column, you specify the type of the weld seam. You can select from one of two options: butt and fillet. The weld type has an influence on the expansion of the heat-affected zone (see [1], Clause 6.1.6.3).

Method
The welding procedure also has an influence on the expansion of the heat-affected zone. In column I, you can specify either the MIG or the TIG method.

Material
In the list, you can select heat-treatable alloys of temper T4 and above (6xxx and 7xxx series) as well as non-heat-treatable alloys in any work-hardened condition (3xxx, 5xxx, and 8xxx series). They have an influence on the characteristic strengths $f_{u,\text{haz}}$ and $f_{c,\text{haz}}$.

Temperature
If the temperature is above 60 °C, there could be a build-up of temperature between weld seam passes. This increases the extent of the heat-affected zone (see [1], Clause 6.1.6.3 (8)).

No. of Heat Paths
In the last column, you specify the number of valid heat paths.

Below the Settings table, you find the Set input for members No. check box. If selected, the settings entered afterwards will be applied to the selected (manual entry of member numbers or graphical selection by means of [$\Box$]) or All members.
2.6 Effective Lengths - Members

The window is subdivided into two parts. The upper table provides summarized information about the factors for the lengths of buckling and lateral-torsional buckling as well as the equivalent member lengths of the members to be designed. The effective lengths defined in RFEM are preset. In the Settings section, you can see further information on the member whose row is selected in the upper section.

To select the member graphically and show its row, click [ ].

You can change the parameters in the table as well as in the Settings tree.

The effective lengths for buckling about the minor z-axis are aligned automatically with the entries of the 1.4 Intermediate Lateral Restraints window. If the intermediate lateral restraints are dividing the member into segments of different lengths, the program displays no values in the columns G, K, and L of Window 1.6.

You can enter the effective lengths manually in the table and in the Settings tree, or define them graphically in the work window upon clicking [...]. To enable the button, click in the text box (see figure above).

The Settings tree manages the following parameters:

- **Cross-Section**
- **Length of member**
- **Buckling Possible** for the member (corresponds to column A)
- **Buckling About Axis y or u** (corresponds to columns B through D)
- **Buckling About Axis z or v** (corresponds to columns E through G)
- **Lateral-Torsional Buckling** (corresponds to columns H to L)

In this table, you can specify for the currently selected member whether to carry out a buckling or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length Factor and the Warping Length Factor for the respective directions. When a factor is modified, the equivalent member length is adjusted automatically, and vice versa.
You can also define the effective length of a member in a dialog box. To open it, click the button shown on the left. It is located on the right below the upper table of the window.

The effective length factors $k_{el,y}$ and $k_{el,z}$ correspond to the following definitions in [1], Table 6.8:

- $k = 0.70$  held in position at both ends + restrained at both ends
- $k = 0.85$  held in position at both ends + restrained at both ends
- $k = 1.00$  held in position at both ends + not restrained at both ends
- $k = 1.25$  held in position at one end + restrained at both ends
- $k = 1.50$  held in position and restrained at one end + not held in position and partially restrained at the other end
- $k = 2.00$  held in position and restrained at one end + free at the other end

The effective length factor can also be specified as User-defined. If you performed an eigenvalue analysis in the RF-STABILITY add-on module, you can select a Buckling mode for determining the factor.

**Buckling Possible**

The stability analyses for flexural buckling and lateral-torsional buckling require that members can resist compressive forces. Members for which such resistance is not possible because of the member type (for example, tension members, elastic foundations, rigid couplings) are excluded from design in the first place. The corresponding rows appear dimmed and a message is displayed in the Comment column.

The Buckling Possible check boxes in table column A Settings tree offer you a control option for the stability analyses: By using them, you determine whether the analyses should or should not be performed for a member.
Buckling About Axis y or z

With the check boxes in the Possible columns, you decide whether a member is susceptible to buckling about the y-axis and/or z-axis. These axes represent the local member axes, where the y-axis is the major and the z-axis the minor member axis. You can freely select the effective length factors $k_{cr,y}$ and $k_{cr,z}$ according to [1], Table 6.8 for buckling about the major or the minor axis.

You can check the position of the member axes in the cross-section graphic in the 1.3 Cross-Sections window (see Figure 2.13, page 16). To go to the RFEM work window, click [View mode]. In the work window, you can display the local member axes by using the context menu of the member or the Display navigator (see Figure below).

If buckling is possible about one or even both member axes, you can enter the effective length coefficients as well as the effective lengths in the columns C and D as well as F and G. The same specifications are possible in the Settings tree.

Alternatively, you can define the effective lengths graphically in the work window upon clicking [...]. This button becomes available when you click in an $L_{cr}$ text box (see Figure 2.20).

When you specify the effective length factor $k_{cr}$, the program determines the effective length $L_{cr}$ by multiplying the member length $L$ by the effective length factor. The text boxes $k_{cr}$ and $L_{cr}$ are interactive.

Lateral-Torsional Buckling Possible

In column H, you can control for which members the program should perform an analysis of lateral-torsional buckling.

Effective length factor $k_{cr}$

To determine $M_{cr}$ by the eigenvalue method, a member model with four degrees of freedom is created in the program background. The following definitions of $k_{cr}$ and $k_{Mr}$ (see page 27) are possible for representing the degrees of freedom on the supports of such a model:

- $k_{cr} = 1.0$ Lateral and torsional restraint at both beam ends
- $k_{cr} = 0.7l_e$ Restrained at the left and lateral and torsional restraint at the right end
- $k_{cr} = 0.7r_i$ Restrained at the right and lateral and torsional restraint at the left end
- $k_{cr} = 0.5$ Restrained at both member ends
- $k_{cr} = 2.0l_e$ Restrained at the left and free at the right member end
- $k_{cr} = 2.0r_i$ Restrained at the left and free at the right member end
A lateral and torsional restraint with $k_z = 1.0$ results in a support with a fixation in direction of the y-axis and a restraint of the torsion about the x-axis (longitudinal axis) of the member. In case of a restraint, the torsion of the cross-section about the z-axis is restrained, too. The abbreviations le and ri refer to the left and right end. The abbreviation le always refers to the support conditions at the member start.

Because the definitions for $k_z$ and $k_w$ always refer to member start and member end, particular attention must be paid when using intermediate restraints: These divide the member into individual segments for the calculation. For cantilevered beams, there would be statically underdetermined segments with lateral and torsional restraints at one end only.

### Warping length factor $k_w$

With the warping length factor $k_w$, you define the support’s fourth degree of freedom, which is also included in the determination of the elastic critical moment for lateral-torsional buckling $M_{cr}$. Specify whether the cross-section is free to warp or if there is a warping restraint.

The definition is similar to the one of the effective length factor $k_z$ (see above); here, however, it is a restraint that describes the prevention of warping. By default, RF-ALUMINIUM takes the member length as the length of lateral-torsional buckling. For a structural element consisting of several members between the supports, it can make sense to define the length for lateral-torsional buckling manually. To this end, you can use the select function [...].

- $k_w = 1.0$: Support free to warp at both member ends
- $k_w = 0.7le$: Restrained at the left and lateral and torsional restraint at the right end
- $k_w = 0.7ri$: Restrained at the right and lateral and torsional restraint at the left end
- $k_w = 0.5$: Warping restraint at both member ends
- $k_w = 2.0le$: Restrained at the left and free at the right member end
- $k_w = 2.0ri$: Restrained at the right and free at the left member end

Because the internal member model requires only four degrees of freedom, a definition of the remaining degrees of freedom (displacement in x- and z-direction) is unnecessary.

### Lateral-Torsional Buckling Length $L_w$

The lengths given in column K are included in the determination of the elastic critical moment for LTB $M_{cr}$.

### Torsional Length $L_T$

The torsional buckling length is necessary to determine the elastic torsional buckling force $N_{cr, T}$ and the elastic torsional-flexural buckling force $N_{cr, TF}$.

Below the Settings table, you find the Set input for members No. check box. If selected, the settings specified afterwards will be applied to the selected (manual entry of member numbers or graphical selection upon clicking [••]) or to All members. This option is useful when you want to apply the same boundary conditions to several members. Please note, however, that this function does not allow you to change already specified settings after the fact.

It may happen that the LTB length $L_w$ or the torsional buckling length $L_T$ differs from the member length or the buckling length. In these cases, it is possible to adjust the lengths $L_w$ and $L_T$ in the columns K and L manually.

### Comment

In the last table column, you can enter your own comments to describe, for example, the selected equivalent member lengths.
2.7 Effective Lengths - Sets of Members

This window appears only if you selected at least one set of members for design in the 1.1 General Data window.

The concept of this window is similar to that of the previous one, 1.6 Effective Lengths - Members. In this window, you can enter the effective lengths for the buckling about the two principal axes of the set of members as described in Chapter 2.6.

For sets of members, however, the parameters $k_z$ and $k_w$ for the checks of lateral-torsional and torsional-flexural buckling are controlled by means of the boundary conditions that you specify in the Windows 1.8 and 1.9. Therefore, column I through K are usually not available.

You have the option to analyze the stability behavior of sets of members by using methods that are also used for individual members. For this, the Stability tab of the Details dialog box offers you three options for the Sets of Members - Member-Like Input (see Figure 3.2, page 35). In this way, you can specify the parameters for lateral-torsional buckling also conventionally for sets of members.

The determination of $x_s$ according to [1], Eq. (6.71) is not recommended for the check of lateral-torsional buckling of buckled sets of members: These bending moments at the start and end of a set of members can result in incorrect values for $x_s$, $\omega_x$, and $\omega_{xLT}$, and thus lead to incorrect results.

Figure 2.23: Window 1.7 Effective Lengths - Sets of Members

[Diagram and table of effective lengths for sets of members]
2.8 Nodal Support - Sets of Members

This window is displayed if you selected at least one set of members for design in the 1.1 General Data window.

If you select the Sets of Members - Member-Like Input option in the Details dialog box (see Figure 3.2, page 35), Window 1.8 will not be shown. Intermediate lateral restraints can be defined in Window 1.4 by means of division points.

The stability analysis of sets of members is based on the loads and boundary conditions of these sets of members. Here, the amplifier $\alpha_{cr}$ of the entire set of members must be determined in order to obtain the elastic critical moment for LTB $M_{cr}$. The calculation of $\alpha_{cr}$ depends on the settings in the Details dialog box (see Chapter 3.1.2, page 35).

To determine the amplifier $\alpha_{cr}$, the program models a plane beam structure with four degrees of freedom per node. To determine the support conditions, use Window 1.8. This table refers to the current set of members (selected in the navigator on the left).

For the definition of nodal supports, the orientation of the axes in the set of members is important. The program checks the position of the nodes. According to Figure 2.25 to Figure 2.28, the program specifies in its background the axes of the nodal supports for Window 1.8.

If all members in the set of members are in a straight line, the local coordinate system of the first member in the set of members represents the equivalent coordinate system.
Even if the members of a set of members are not in a straight line, they still must lie in one plane. In Figure 2.26, it is a vertical plane. In this case, the $X'$-axis is horizontal and orientated in the direction of the plane. The $Y'$-axis is also defined as horizontal and perpendicular to the $X'$-axis. The $Z'$-axis is orientated perpendicularly downwards.

If the members of the buckled set of members lie in a horizontal plane, the $X'$-axis runs parallel to the $X$-axis of the global coordinate system. The $Y'$-axis thus runs in the opposite direction to the global $Z$-axis, while the $Z'$-axis runs parallel to the global $Y$-axis.

Figure 2.28 shows the general case of a buckled set of members: The members lie not on a straight line but on an inclined plane. The definition of the $X'$-axis results from the intersection line between an inclined plane and the horizontal plane. The $Y'$-axis runs perpendicular to the $X'$-axis and perpendicular to the inclined plane. The $Z'$-axis is defined as rectangular to the $X'$- and $Y'$-axis.
2.9 Member End Releases - Sets of Members

This window is displayed if you select at least one set of members in the 1.1 General Data window for design. In this window, you can define releases for members in a set of members, which, for structural reasons, do not transfer the degrees of freedom restrained in Window 1.8 as internal forces. This table does not refer to the current set of members (selected in the navigator on the left).

If in the Details dialog box (see Figure 3.2, page 35) you select the Member-Like Input, Window 1.9 will not be shown. You can then define the intermediate lateral restraints by means of division points in Window 1.4.

In column B, you specify, at which Member Side (member end) the release exits or if both member sides are internally hinged.

In the columns C through F, you can define releases or spring constants in order to align the set of members model with the support conditions in Window 1.8.
2.10 Serviceability Data

The last input window controls various specifications for the serviceability limit state design. It is shown only if you select at least one case in the Serviceability Limit State tab of Window 1.1 (see Chapter 2.1.2, page 12).

![Figure 2.30: Window 1.10 Serviceability Data](image)

In column A, you can decide if the deformation refers to individual members, lists of members, or sets of members.

In column B, you specify the members or sets of members for the design. Alternatively, you can select them graphically in the RFEM work window upon clicking [...]. The Reference Length is shown automatically in column D. All lengths of the members, sets of members, or lists of members are preset. You can adjust the values after selecting the corresponding check boxes in column C Manually.

In column E, you specify the governing Direction for the deformation analysis. Here, you can select the directions of the local member axes y or z (or u and v for asymmetrical sections).

In column F, you can consider a Precamber w.t.

To apply the limit deformations correctly, the Beam Type is very important. In column G, you can select whether to represent a beam or a cantilever and at which end there is no support.

The selection in the Serviceability tab of the Details dialog box controls whether the deformations refer to the undeformed initial system or the displaced ends of the member or set of members (see Figure 3.3, page 38).
3 Calculation

3.1 Detail Settings

Before starting the [Calculation], check the design details. To open the corresponding dialog box, you can use the [Details] button available in every window of the add-on module.

The Details dialog box contains the following tabs:

- Ultimate Limit State
- Stability
- Serviceability
- Other

3.1.1 Ultimate Limit State

Figure 3.1: Dialog box Details, tab Ultimate Limit State

Alternative Values

This section lists factors that can be determined differently according to EN 1999-1-1. If a check box is selected, the standard value is used. The corresponding clauses from the standard are given.

To select all or clear the selection of all check boxes, click the [(Un)select All] button.

Options

In RF-ALUMINIUM, cross-sections assigned to class 1 or 2 are designed plastically. If you do not want this to happen, you can set the Elastic design also for these cross-section classes.

An elastic shear design is possible so that the shear force check is not only performed on the basis of plastic shear resistance (default setting), but the shear stress analysis is performed, too.
You can activate the elastic design of angle sections to design them according to [1], Clauses 6.2.5 through 6.2.10 with the stresses instead of the resistance values (default setting). The factors $\xi_0$, $\eta_0$, $\gamma_0$ and $\omega_0$ are taken as 1.00.

Optionally, you can also perform an elastic design of general cross-sections based on stresses according to [1], Clauses 6.2.5 through 6.2.10. This covers some cross-sections from the RFEM library or from SHAPE-THIN. In this case, the design is based not on the resistances (default setting) but on the stresses. Furthermore, you can activate the design of general cross-sections according to 6.2.1(5). For this, the yielding stresses according to VON MISES are calculated in every stress point. The greatest design ratio according to [1], Eq. (6.15) is then used to determine the governing stress point and the final design ratio for each $x$-location of the member. The parameter $C$ can be set in the National Annex Settings dialog box (see Chapter 2.1.3, page 13).

The Design of plate girders according to 6.7 is appropriate for cross-sections that fulfill the requirements of a plate girder and that are not indicated as "general" sections. However, RF-ALUMINIUM does not design longitudinal and transverse stiffeners.

The Shear design of solid cross-sections option allows you to check the shear and bending of solid sections. If you clear the selection, the bending moments, torsional moment, and shear forces are neglected, even if they were calculated in RFEM.

In case of a Shear buckling design of webs, the designs are carried out according to [1], Clause 6.5.5 and 6.7.4.

The partial safety factors $\gamma_M$ of the materials are managed in the National Annex Settings dialog box (see Chapter 2.1.3, page 13).

Classification of Cross-Sections

For sections with SHAPE-THIN arc elements, the width-to-thickness ratios can result in classification problems, because RF-ALUMINIUM considers only unreinforced cross-section parts (see [1], Figure 6.1 (a)). By selecting the Ignore classification of curved parts check box, you exclude short fillet curves from the classification if the user-defined $c/t$-ratio is not reached. Longitudinal stiffening ribs, edge lips, or bulbs have no influence on the designs.

By default, the check box Separately classify the load components acc. to 6.3.3 NOTE 1 and NOTE 2 is selected. If necessary, you can clear this default setting.

Transverse Welds

If segments of members are welded to each other, the transverse welds lead to a softening in the heat-affected zone (HAZ). To consider the reduced strength according to [1], Clause 6.1.6.2, NOTE 2, you can choose one of two options: For the Reduced stress method, the $f_{haz}$ and $f_{u,haz}$ strength values are reduced according to [1], Table 3.2. The Effective cross-section method, on the other hand, uses reduced cross-section values for the designs (Surface A, elastic moduli W, moments of inertia I).

You can specify the parameters of the transverse welds in the 1.5 Transverse Welds window.
3.1.2 Stability

Stability Analysis
The Perform stability analysis check box is available if, in addition to the cross-section checks, you also want to run a stability analysis. If you clear the check box, the Windows 1.4 through 1.9 are not shown.

If you select this check box, you can specify the axes that are relevant for the flexural buckling analysis. In addition, you can Include second-order effects according to [1], Clause 5.2.2 (4) with a manually definable factor for bending moments. For example for a frame, whose governing buckling mode is lateral deflection, you can thus determine the internal forces according to the geometrically linear static analysis and increase them by using the appropriate factors. Increasing the bending moments has no effect on the check for flexural buckling resistance according to [1], Clause 6.3.1.

Determination of Elastic Critical Moment for LTB
The elastic critical moment is determined according to the default setting Automatically by Eigenvalue Method. The program uses a finite member model to determine $M_{cr}$ under consideration of the following points:

- Dimensions of gross cross-section
- Load type and position of load application point
- Actual moment distribution
- Lateral restraints (from support conditions)
- Actual boundary conditions

The degrees of freedom can be controlled by using the factors $k_z$ and $k_w$ (see Chapter 2.6, page 26).
3 Calculation

When determining the elastic critical moment *Automatically by comparison of moment distributions*, the coefficient $C_1$ is determined by means of the moment distribution. To view the load and moment distributions in a dialog box, click [Info]. The coefficients $C_2$ and $C_3$ are – if required – automatically determined by Eigenvalue Method.

With the *Manually in Window 1.6* option, the header in column J of Window 1.5 changes to $M_e$, so that you can enter the elastic critical moment directly.

If transverse loads exist, it is important to define where these forces act on the section: Depending on the *Load application*, the transverse loads can have a stabilizing or destabilizing effect, and thus have a decisive influence on the elastic critical moment.

**Sets of Members - Member-Like Input**

You can analyze the stability behavior of sets of members by four methods. In general, the *Member-Like Input* is recommended only for straight sets of members.

If you use the default setting *Do not use member-like input*, the program will run a general analysis based on the factor $\alpha_{cr}$. In Window 1.8, you specify the support conditions for each individual set of members. The factors $k_z$ and $k_w$ in Window 1.7 are of no relevance.

The *Use for all sets of members* option allows you to analyze sets of members in relation to the stability behavior like individual members. You can use this approach if each set of members corresponds to a single-member model.

You can also use the member-like input *only for straight sets of members* with the same cross-section (for example, continuous member). The factors $k_z$ and $k_w$, which are to be specified in Window 1.7, are used for the determination of the support conditions $\beta$, $u_y$, $\varphi_x$, $\varphi_z$, and $\omega$. The Windows 1.8 and 1.9 are not displayed.

By using the last option, you limit the member-like input to *Straight sets of members without intermediate restraints* according to the definition in RFEM: For the member-like input, only sets of members that have RFEM supports at their ends are considered. This option is suitable for the design of, for example, single-span beams or cantilevers. The Windows 1.8 and 1.9 are not displayed. Beams that are connected laterally at intermediate nodes cannot be considered.

**Determination of Distance for Studied Section**

The distance $x_s$ is given in [1], Figure 6.14. It describes the distance between the analyzed cross-section and a support or point of contraflexure of the deflection curve for elastic buckling of compressive force only. You can conservatively *Use half of the effective length* or $x_s$, according to [1], Eq. (6.71) for members with end moments (transverse loads are not allowed). Because the equation gives only a single value for $x_s$, this value is used for every portion of the member.

The Eq. (6.71) [1] is limited to linear moment distributions in the member. Furthermore, the right side of the equation must yield a value between – 1.0 and 1.0, because the left side represents a cosine. If one of the two conditions is not fulfilled, the equation is not used: $x_s$ is then taken as half of the effective length for the segment.

In the current program version, known buckling modes are not presupposed. The determination of $x_s$ as for the common buckling modes on the basis of bending moments and twists are not implemented.

**Limit Values for Special Cases**

To check unsymmetrical cross-sections under intended axial compression according to [1], Clause 6.3.1, you can neglect *small moments* about the major and minor axis in this dialog box section.

Similarly, for the pure bending check according to [1], Clause 6.3.2, you can neglect *small compression forces* by specifying a limit ratio $N_{c,Ed}$ to $N_{pl}$. 
3 Calculation

Intended Torsion is not clearly specified in EN 1999-1-1. If there is torsion not exceeding the default shear stress ratio of 5%, it is neglected in the stability analysis; results for the flexural and torsional-flexural buckling are shown.

If one of the limits is exceed in this section, a message appears in the results window. No stability analysis is run. The cross-section checks are run independent from this. These limit settings are not part of the EN 1999-1-1 or a National Annex. Changing the limits is within the user’s responsibility.

Slenderness Determination

Annex I of EN 1999-1-1 provides alternative simplified methods for the calculation of the relative slendernesses for torsional-flexural buckling without axial force (Annex I.2, clause 2) as well as torsional and torsional-flexural buckling with axial force (Annex I.4, section 2). You can activate these alternative methods by selecting the corresponding check boxes.

The relative slendernesses of unequal angles, back-to-back-angles, cruciforms, sections with fillet welds and bulbs, as well as general sections are never determined according to the alternative methods.

Torsional and Torsional-Flexural Buckling

Clause 6.3.1.4(1) gives cross-section types for which the check of torsional and torsional-flexural buckling may be ignored: hollow sections, doubly-symmetric l-sections, and sections composed of radiating outstands (angles, tees) that are classified as class 1 and 2. The check box allows you to perform stability analyses for such sections nonetheless – except for hollow sections which are generally excluded from the stability design.
3.1.3 Serviceability

By using the options in this dialog box section, you can decide whether to refer the maximum deformations to the *Shifted member ends / set of members ends* (connecting line between start and end node of the deformed system) or to the *Undeformed initial system*. Usually, the deformations are to be checked relative to the displacements in the global analysis.

You can check the limit deformations in the *National Annex Settings* dialog box and, if necessary, adjust them (see Figure 2.9, page 13).
3 Calculation

3.1.4 Other

Cross-Section Optimization
The optimization is targeted on the maximum design ratio of 100%. If necessary, you can also specify a different upper limit in the text box.

Check of Member Slendernesses
In the two text boxes, you can specify the limit values $\lambda_{\text{lim}}$ to control the member slenderness. You can make separate specifications for members with pure tension and for members with bending and compression.

In Window 3.3, the limit values are compared with the actual member slendernesses. To display this window after the calculation (see Chapter 4.8, page 49), select the corresponding check box in the Display Result Windows dialog box section.

Cross-Section Database
In RF-ALUMINIUM, you can also design sections that actually consist of steel (rolled sections). If you clear the selection, only cross-sections of the categories Parametric - Thin-Walled, Parametric - Massive, or User-Defined Sections are designed.

Settings of SHAPE-THIN Cross-Sections
This check box ensures that the cross-section is symmetric relative to the principal axis system. Some SHAPE-THIN sections or general RFEM sections do not, among other things, meet the requirements of the RF-ALUMINIUM design routine, because the $y$-axis is always assumed as major and the $z$-axis as minor axis. If, for example, $I_y < I_z$, or the rotation of the main axis shows that the $z$-axis represents the principal axis, the results of RF-ALUMINIUM can result in misinterpretations.
3 Calculation

The check box allows you to check the symmetry of general sections, independent from the SHAPE-THIN analysis. If both methods yield different results, an error message appears.

For closed cross-sections, different proof strength and ultimate strengths than for open cross-sections apply (see [1], Table 3.2b). In addition, there are different design methods, for example according to [1], Clause 6.2.9.1 and 6.2.9.2. If the Bredt torsional constant $I_{\text{Bredt}}$ component of the torsion constant $I_t$ is greater than the specified value, the cross-section is taken as closed. In this case, you can also neglect the possibility of torsional and torsional-flexural buckling (see [1], Clause 6.3.1.4 NOTE).

The Internal divisions of cross-section elements has an influence on the calculation time for the determination of the cross-section properties. For Arc elements, you need to specify the angle in degrees [°].

Display Result Windows

Here, you can select which results windows including parts list you want to display. These windows are described in Chapter 4 Results.

Window 3.3 Member Slendernesses is deactivated by default.
3 Calculation

3.2 Start Calculation

To start the calculation in RF-ALUMINIUM, use the [Calculation] button available in every input window of the module.

RF-ALUMINIUM searches for available results of the load cases, load combinations, and result combinations selected for design. If no results can be found, the program starts the RFEM calculation to determine the design-relevant internal forces.

You can also start the calculation in the RFEM user interface. To do this, use the To Calculate dialog box (menu Calculation → To Calculate), containing design cases as well as load cases or load combinations.

![Figure 3.5: Dialog box To Calculate](image)

If the RF-ALUMINIUM cases are missing in the Not Calculated list, select All or Add-on Modules in the drop-down list at the end of the dialog box section.

To transfer the selected RF-ALUMINIUM cases to the section on the right, click ➔. Click [OK] to start the calculation.

Alternatively, you can start the calculation of a design case by using the drop-down list in the toolbar. In this list, select the RF-ALUMINIUM case, and then click [Show Results].

![Figure 3.6: Direct calculation of an RF-ALUMINIUM design case in RFEM](image)

Subsequently, you can observe the design process in a separate dialog box.
4. Results

Immediately after the calculation, the 2.1 Design by Load Case window is shown.

The designs are shown in the result windows 2.1 through 2.5, sorted by different criteria. Windows 3.1 and 3.2 list the governing internal forces, Window 3.3 provides information about member slendernesses. Windows 4.1 and 4.2 show the parts lists by members and sets of members.

To open a window, click the corresponding entry in the navigator. To go to the previous or next input window, use the buttons shown on the left. Alternatively, you can use the function keys to go to the next [F2] or previous [F3] window.

To save the results, click [OK]. Thus you exit RF-ALUMINIUM and return to the main program.

Chapter 4 Results describes the different results windows one by one. Chapter 5 Evaluation of Results describes evaluating and checking results (see page 52 f).
4 Results

4.1 Design by Load Case

The upper part of the window shows a summary of the governing checks sorted by load case, load combination, and result combination. Moreover, the list is sorted by ultimate and serviceability limit state design.

The lower part of the window provides detailed information about the cross-section properties, design internal forces, and check parameters for the load case selected above.

Description

This column shows the descriptions of the load cases, load combinations, and result combinations selected for the designs.

Member No.

This column shows the number of the member with the maximum design ratio for the analyzed action.

Location x

This column shows the corresponding x-location where the member’s maximum design ratio occurs. For the table output, the program uses the following member locations:

- Start and end node
- Division points according to possibly defined member division (see RFEM Table 1.16)
- Member division according to specification for member results (RFEM dialog box Calculation Parameters, tab Global Calculation Parameters)
- Extreme values of the internal forces

Design

Columns D and E show the design conditions according to EN 1999-1-1.

The length of the color scale graphically represents the respective design ratio.
4 Results

Design According to Formula
This column shows the equations of the standard used in the checks.

DS
The last column provides information about the relevant design situations (DS): PT or AC for the ultimate limit state or one of the three design situations for the serviceability limit state (SC, SF, SQ) according to the specifications in the 1.1 General Data window (see Figure 2.7, page 12).

4.2 Design by Cross-Section

This window shows the maximum design ratios of all members and actions selected for design, sorted by cross-section. For each cross-section, the results are sorted by cross-section check, stability analysis, and serviceability limit state design, respectively.
4 Results

4.3 Design by Set of Members

This results window is displayed if you have selected at least one set of members for design. The window lists the maximum design ratios sorted by set of members. The Member No. column shows the number of the one member within the set of members that bears the maximum ratio for the respective design criterion. The output by set of members clearly presents the design for an entire structural group (for example, a frame).
4 Results

4.4 Design by Member

This results window shows the maximum design ratios for the individual designs sorted by member number. The columns are described in Chapter 4.1, page 43.

4.5 Design by x-Location

Figure 4.5: Window 2.4 Design by Member

Figure 4.6: Window 2.5 Design by x-Location
This results window lists the maxima for each member at the locations \( x \) resulting from the division points in RFEM:

- Start and end node
- Division points according to possibly defined member division (see RFEM Table 1.16)
- Member division according to specification for member results (RFEM dialog box Calculation Parameters, tab Global Calculation Parameters)
- Extreme values of the internal forces

### 4.6 Governing Internal Forces by Member

This window shows for each member the governing internal forces that result in maximum design ratios in each check.

**Location \( x \)**

This column shows the corresponding \( x \)-location where the maximum design ratio of the member occurs.

**Load Case**

This column displays the number of the load case, load combination, or result combination whose internal forces produce the maximum design ratio.

**Forces / moments**

For each member, the axial and shear forces as well as the torsional and bending moments are shown that result in the highest design ratios for the respective cross-section check, stability analysis, and ultimate limit state design.

**Design According to Formula**

The final column provides information on the check types and formulas used in the checks according to EN 1999-1-1.
4.7 Governing Internal Forces by Set of Members

This window shows the internal forces that result in the maximum design ratios in the design of each set of members.
4 Results

4.8 Member Slendernesses

To show this results window, select the corresponding check box in the Other tab of the Details dialog box (see Figure 3.4, page 39).

The table lists the effective member slendernesses of the designed members for both principal member axis directions. They were determined in dependence of the load type. At the end of the list, you find a comparison of the limit values defined in the Other tab of the Details dialog box (see Figure 3.4, page 39).

Members of the "Tension" or "Cable" type do not appear in this table.

The table is for informational purposes only. No stability analysis for slendernesses is provided.
4.9 Parts List by Member

Finally, RF-ALUMINIUM provides a summary of all cross-sections used in the design case.

![Parts List by Member](image)

By default, this list contains only the designed members. If you need a parts list for all members of the model, select the corresponding option in the Other tab of the Details dialog box (see Figure 3.4, page 39).

**Part No.**
The program automatically assigns part numbers to similar members.

**Cross-Section Description**
This column shows the cross-section numbers and descriptions.

**Number of Members**
This column shows for each part how many similar members are used.

**Length**
This column displays the length of a single member.

**Total Length**
This column shows the product determined from the previous two columns.

**Surface Area**
For each part, the program indicates the surface area relative to the total length. The surface area is determined from the Surface of the cross-sections that can be seen in Windows 1.3 and 2.1 through 2.5 in the cross-section properties (see Figure 2.16, page 19).
Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The Unit Weight is the weight of the section relative to the length of one meter.

Weight
The values of this column are determined from the respective product of the entries in columns C and G.

Total Weight
The final column indicates the total weight of each part.

Sum
At the bottom of the list, you find a summary of the values in the columns B, D, E, F, and I. The last cell of the Total Weight column informs you about the total amount of steel required.

4.10 Parts List by Set of Members

The final results window is displayed if you have selected at least one set of members for design. It summarizes entire structural groups (for example, a horizontal beam) in a parts list.

The columns are described in the previous chapter. If different cross-sections are used in the set of members, the program averages the surface area, volume, and cross-section weight.
5. Evaluation of Results

You can evaluate the design results in different ways. The buttons below the upper table can be helpful.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ultimate limit state</td>
<td>Shows or hides the results of the ultimate limit state design</td>
</tr>
<tr>
<td></td>
<td>Serviceability limit state</td>
<td>Shows or hides the results of the serviceability limit state design</td>
</tr>
<tr>
<td></td>
<td>Result combination</td>
<td>Creates a new result combination from the governing load cases and load combinations</td>
</tr>
<tr>
<td></td>
<td>Color bars</td>
<td>Shows or hides the colored reference scales in the results windows</td>
</tr>
<tr>
<td>≥ 1.0</td>
<td>Filter parameters</td>
<td>Gives the criterion for filtering the tables: ratios greater than 1, maximum value, or user-defined limit</td>
</tr>
<tr>
<td></td>
<td>Apply filter</td>
<td>Shows only rows with selected filter parameter (ratio &gt; 1, maximum, user-defined limit)</td>
</tr>
<tr>
<td></td>
<td>Result diagrams</td>
<td>Opens the dialog box Result Diagram on Member → Chapter 5.2, page 55</td>
</tr>
<tr>
<td></td>
<td>Excel export</td>
<td>Exports the table to MS Excel / OpenOffice → Chapter 7.4.3, page 66</td>
</tr>
</tbody>
</table>
5 Evaluation of Results

<table>
<thead>
<tr>
<th>Member selection</th>
<th>Allows for the graphical selection of a member to display its results in the table</th>
</tr>
</thead>
<tbody>
<tr>
<td>View mode</td>
<td>Goes to the RFEM work window for changing the view</td>
</tr>
</tbody>
</table>

Table 5.1: Buttons in the Windows 2.1 through 2.5

5.1 Results on the RFEM model

You can also use the RFEM work window to evaluate the design results.

RFEM background graphic and view mode

The RFEM work window in the background is useful for finding the location of a member in the model. The member selected in the RF-ALUMINIUM results window is highlighted in the selection color in the background graphic. Furthermore, an arrow indicates the member x-location displayed in the currently selected table row.

If you cannot improve the display by moving the RF-ALUMINIUM window, click [Jump to Graphic] to start the View Mode. Thus, you hide the module window so that you can change the display in the RFEM user interface. In the view mode, you can use the functions of the View menu, for example zooming, moving, or rotating the display. The indication arrow remains visible.

To return to the RF-ALUMINIUM module, click [Back].

RFEM work window

You can also graphically check the design ratios in the RFEM model. First, click [Graphics] to exit the design module. In the RFEM work window, the design ratios are now displayed like the internal forces of a load case.

In the Results navigator, you can specify which design ratios of the ultimate or serviceability limit state designs should be graphically presented.

To display or hide design results, use the [Show Results] button similar to the display of internal forces. To display the result values, click the [Show Values] button in the toolbar to the right.

The RFEM tables are of no relevance to the evaluation of design results.
To set the design cases, you can use the list in the toolbar.

To adjust the results display, use the Display navigator below the entry Results → Members. The display of the design ratios is Two-Colored by default.

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), the color panel becomes available. It provides the common control functions described in the RFEM manual, Chapter 3.4.6.

You can include the design result graphics in the printout report (see Chapter 6.2, page 58).

To return to the add-on module, click [RF-ALUMINIUM] in the panel.
5 Evaluation of Results

5.2 Result diagrams

You can also graphically evaluate the result distributions of a member in the result diagram. To do this, select the member (or set of members) in the RF-ALUMINIUM results window by clicking in the corresponding table row of the member. Then, open the Result Diagram on Member dialog box by clicking the button shown on the left. The button is located at the end of the upper table (see Figure 5.1, page 52).

To display the result diagrams, select in the RFEM menu Results → Result Diagrams for Selected Members or use the button in the RFEM toolbar shown on the left.

A window opens, graphically presenting the distribution of the maximum design values on the member or set of members.

![Figure 5.5: Dialog box Result Diagram on Member](image)

To select the relevant RF-ALUMINIUM design case, use the drop-down list in the toolbar of the dialog box.

The Result Diagram on Member dialog box is described in the RFEM manual, Chapter 9.5.
5 Evaluation of Results

5.3 Filter for Results

The results windows in RF-ALUMINIUM allow you to sort the results by various criteria. In addition, you can use the filter options to graphically evaluate the results as described in Chapter 9.9 of the RFEM manual.

In RF-ALUMINIUM, you can also use the Visibilities (see RFEM manual, Chapter 9.9.1) to filter the members for the evaluation.

Filtering designs

The design ratios can easily be used as filter criteria in the RFEM work window, which you can access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is not, select in the RFEM menu View → Control Panel (Color Scale, Factors, Filter)
or use the toolbar button shown on the left.

The panel is described in the RFEM manual, Chapter 3.4.6. In the first panel tab (Color spectrum), you can define the filter settings for the results. Because this register is not available for the two-colored results display, you have to use the Display navigator and set the display options With/Without Diagram or Cross-Sections first.

As the figure above shows, the color spectrum can be set in such a way that only ratios higher than 0.50 are shown in a color range between blue and red.

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Members), you can display all design ratio diagrams that are not covered by the color spectrum. Those diagrams are represented by dotted lines.

Figure 5.6: Filtering design ratios with adjusted color spectrum
**Filtering members**

In the *Filter* tab of the control panel, you can specify the numbers of particular members to display their results exclusively, that is, filtered. This function is described in the RFEM manual, Chapter 9.9.3.

![Figure 5.7: Member filter for the design ratios of an edge beam](image)

Unlike the partial view function (Visibilities), the graphic also displays the entire model. The figure above shows the design ratios in the edge beam of a container. The remaining members are displayed in the model but are shown without design ratios.
6. Printout

6.1 Printout Report

Like in RFEM, the program generates a printout report for the RF-ALUMINIUM results, to which you can add graphics and descriptions. The selection in the printout report determines which data from the design module will be included in the final printout.

The printout report is described in the RFEM manual. In particular, Chapter 10.1.3.4 Selecting Data of Add-on Modules describes how to select input and output data from add-on modules for the printout report.

For large structural systems with many design cases, it is recommended to split the data into several printout reports, thus allowing for a clearly-arranged printout.

6.2 Graphic Printout

In RFEM, you can add every picture displayed in the work window to the printout report or send it directly to a printer. In this way, you can also prepare the design ratios displayed on the RFEM model for the printout.

Printing graphics is described in the RFEM manual, Chapter 10.2.

Designs on the RFEM Model

To print the current graphic of the design ratios, select in the menu

File → Print

or use the toolbar button shown on the left.

Result diagrams

In the Result Diagram on Member dialog box, you can also send the graphic with the design values to the report using the [Print] button. Furthermore, you can print the graphic directly.

The following dialog box appears.
This dialog box is described in Chapter 10.2 of the RFEM manual. The manual also describes the Options and Color Scale tabs.

To move a graphic within the printout report, use the drag-and-drop function.

To adjust a graphic in the printout report after the fact, right-click the corresponding entry in the navigator of the printout report. The Properties option in the context menu opens the Graphic Printout dialog box, offering various options for adjustment.
7. General Functions

This chapter describes useful menu functions and export options for the designs.

7.1 Design Cases

Design cases allow you to group members for the design. In this way, you can consider groups of structural components or analyze members with particular design specifications (for example, changed materials, partial safety factors, optimization).

It is no problem to analyze the same member or set of members in different design cases.

To calculate an RF-ALUMINIUM design case, you can also use the load case list in the RFEM toolbar.

Creating new design case

To create a new design case, select in the RF-ALUMINIUM menu

File → New Case.

The following dialog box appears:

Figure 7.1: Dialog box New RF-ALUMINIUM Case

In this dialog box, enter a No. (one that is still available) for the new design case. An appropriate Description will make the selection in the load case list easier.

Now click [OK] to open the 1.1 General Data window of RF-ALUMINIUM where you can enter the design data.

Renaming design case

To change the description of a design case, select in the RF-ALUMINIUM menu

File → Rename Case.

The following dialog box appears:

Figure 7.2: Dialog box Rename RF-ALUMINIUM Case

In this dialog box, you can write a different Description as well as a different No. for the design case.
Copying design case

To copy the input data of the current design case, select in the RF-ALUMINIUM menu 

File → Copy Case.

The following dialog box appears:

![Copy RF-ALUMINIUM Case dialog box](image)

Figure 7.3: Dialog box Copy RF-ALUMINIUM

Define the No. and, if necessary, a Description for the new case.

Deleting design case

To delete design cases, select from the RF-ALUMINIUM menu 

File → Delete Case.

The following dialog box appears:

![Delete Cases dialog box](image)

Figure 7.4: Dialog box Delete Case

First, select the design case in the Available Cases section. To delete the selected case, click [OK].
7 General Functions

7.2 Cross-Section Optimization

The design module offers you the option to optimize overstressed or little utilized cross-sections. To do this, select from the lists in column D or E of the 1.3 Cross-Sections window whether to determine the cross-section From current row or from the user-defined Favorites (see Figure 2.13, page 16). Alternatively, you can start the cross-section optimization in the results windows by using the context menu.

During the optimization process, the module determines the cross-section that fulfills the design conditions in the most optimal way, that is, comes as close as possible to the maximum allowable design ratio specified in the Details dialog box (see Figure 3.4, page 39). The required cross-section properties are determined with the internal forces from RFEM. If another cross-section proves to be more favorable, this new cross-section is used for the design. Then, the graphic in Window 1.3 shows two cross-sections: the original cross-section from RFEM and the optimized one (see Figure 7.7).

For a parametric cross-section, the following dialog box appears when you select ‘Yes’ from the drop-down list.

![Figure 7.5: Context menu for cross-section optimization](image)

![Figure 7.6: Dialog box Welded Cross-Sections - Symmetric I-Section - Optimize](image)
By selecting the check boxes in the **Optimize** column, you decide which parameter(s) you want to modify. This enables the **Minimum** and **Maximum** columns, where you can specify the upper and lower limits of the parameter. The **Increment** column specifies the interval by which the dimensions of the parameter vary during the optimization process.

If you want to **Keep current side proportions**, select the corresponding check box. In addition, you must select at least two parameters for optimization.

Cross-sections built up from rolled cross-sections cannot be optimized.

Please note that the internal forces will not be recalculated automatically with the changed cross-sections in the optimization. It is up to you to decide which cross-sections you want to transfer to RFEM for recalculation. Due to the changed stiffnesses in the structural system, the internal forces from the optimized cross-section may vary significantly. Therefore, it is recommended to recalculate the internal forces of the modified cross-section data after the first optimization, and then to optimize the cross-sections once again.

You can export the modified cross-sections to RFEM. To do this, go to the 1.3 **Cross-Sections** window, and then select in the menu **Edit → Export All Cross-Sections to RFEM.**

Alternatively, you can use the context menu in Window 1.3 to export optimized cross-sections to RFEM.

Before the modified materials are transferred to RFEM, a query appears as to whether you want to delete the results in RFEM.

After you confirm the query and start the [Calculation] in RF-ALUMINIUM, the RFEM internal forces and designs are determined in a single calculation run.

If the modified cross-sections are not exported to RFEM, you can reimport the original cross-sections in the design module by using the options shown in Figure 7.7. Please note that this option is available in the 1.3 **Cross-Sections** window only.
7.3 Units and Decimal Places

Units and decimal places for RFEM and the add-on modules are managed in one common dialog box. To specify the units for RF-ALUMINIUM, select on the module menu

Settings → Units and Decimal Places.

The dialog box known from RFEM appears. In the Program / Module dialog box section, RF-ALUMINIUM is preset.

![Figure 7.9: Dialog box Units and Decimal Places](image)

To reuse the settings in other models, save them as a user-profile. The functions are described in the RFEM manual, Chapter 11.1.3.
7 General Functions

7.4 Data Exchange

7.4.1 Exporting Materials to RFEM

If you adjusted the materials in RF-ALUMINIUM for design, you can export the modified materials to RFEM in a similar way as you export cross-sections. To do this, go to the 1.2 Materials window, and then select in the menu

Edit → Export All Materials to RFEM.

You can also export the changed materials to RFEM by using the context menu in Window 1.2.

Before the modified materials are exported to RFEM, a query appears as to whether you want to delete the results in RFEM. After you confirm it and start the [Calculation] in RF-ALUMINIUM, the RFEM internal forces and designs are determined in a single calculation run.

If the modified materials are not exported to RFEM, you can transfer the original materials to the design module, using the options shown in Figure 7.10. Please note, however, that this option is available in the 1.2 Materials Window only.

7.4.2 Exporting Effective Lengths to RFEM

If you adjusted the effective lengths in RF-ALUMINIUM for design, you can export the modified effective lengths to RFEM. To do this, go to the 1.6 Effective Lengths - Members Window, and then select in the menu

Edit → Export All Effective Lengths to RFEM.

You can also export the effective lengths to RFEM by using the context menu in Window 1.6.

Before the modified materials are transferred to RFEM, a query appears as to whether you want to delete the results in RFEM.

If the modified effective lengths are not exported to RFEM, you can transfer the original effective lengths to the design module, using the options shown in Figure 7.11. Please note that this option is available only in windows 1.6 Effective Lengths - Members and 1.7 Effective Lengths - Sets of Members.

7.4.3 Exporting Results

You can use the RF-ALUMINIUM results also in other programs.

Clipboard

To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To insert the cells, for example in a word processor, press [Ctrl]+[V]. The headers of the table columns are not transferred.
Printout report
You can print the data of the RF-ALUMINIUM module into the printout report (see Chapter 6.1, page 58) for export. Then, in the printout report, you can export them by selecting in the report menu

File → Export in RTF.

This function is described in the RFEM manual, Chapter 10.1.11.

Excel / OpenOffice
RF-ALUMINIUM provides a function for the direct data export to MS Excel, OpenOffice.org Calc, or the file format CSV. To open the corresponding dialog box, select in the module menu

File → Export Tables.

The following dialog box appears.

![Figure 7.12: Dialog box Export - MS Excel](image)

Having selected the relevant options, you can start the export by clicking [OK]. Excel or OpenOffice are started automatically. You do not need to open the programs beforehand.

![Figure 7.13: Results in Excel](image)
8. Worked Example: Column Subject to Biaxial Bending

A stability analysis is performed for flexural buckling and torsional-flexural buckling of a column subject to biaxial bending, taking into account the interaction conditions.

8.1 Design values

System and loading

![Diagram of system and design loads](image)

Design values of the static loads

\[
N_d = 16 \text{ kN} \\
q_{zd} = 4 \text{ kN/m} \\
F_{yd} = 2 \text{ kN}
\]

Cross-section: IS 300/120/5/10


Lengths:

\[
L_{cr,y} = 4 \text{ m} \\
L_{cr,z} = 4 \text{ m} \\
L_L = 4 \text{ m} \\
L_T = 4 \text{ m}
\]

Internal forces according to first-order analysis

![Diagram of internal forces](image)
8 Worked Example: Column Subject to Biaxial Bending

Design location (governing x-location)
The design is carried out for all x-locations (see Chapter 4.5) of the equivalent member. The governing location is at x = 2.00 m. RFEM determines the following internal forces:
\[ N = -16.00 \text{ kN} \quad M_y = 8.00 \text{ kNm} \quad M_z = 2.00 \text{ kNm} \quad V_y = 1.00 \text{ kN} \quad V_z = 0.00 \text{ kN} \]

8.2 Cross-Section Properties

<table>
<thead>
<tr>
<th>Cross-section property</th>
<th>Symbol</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-sectional area</td>
<td>A</td>
<td>38.00</td>
<td>cm²</td>
</tr>
<tr>
<td>Moment of inertia</td>
<td>I_y</td>
<td>5962.67</td>
<td>cm⁴</td>
</tr>
<tr>
<td>Moment of inertia</td>
<td>I_z</td>
<td>288.29</td>
<td>cm⁴</td>
</tr>
<tr>
<td>Governing radius of gyration</td>
<td>r_y</td>
<td>12.53</td>
<td>cm</td>
</tr>
<tr>
<td>Governing radius of gyration</td>
<td>r_z</td>
<td>2.75</td>
<td>cm</td>
</tr>
<tr>
<td>Polar radius of gyration</td>
<td>r_o</td>
<td>12.83</td>
<td>cm</td>
</tr>
<tr>
<td>Weight</td>
<td>wt</td>
<td>10.30</td>
<td>kg/m</td>
</tr>
<tr>
<td>Torsional constant</td>
<td>J</td>
<td>8.79</td>
<td>cm⁴</td>
</tr>
<tr>
<td>Warping constant</td>
<td>I_ω</td>
<td>60552.00</td>
<td>cm⁶</td>
</tr>
<tr>
<td>Elastic section modulus</td>
<td>S_y</td>
<td>397.51</td>
<td>cm³</td>
</tr>
<tr>
<td>Elastic section modulus</td>
<td>S_z</td>
<td>48.05</td>
<td>cm³</td>
</tr>
<tr>
<td>Plastic section modulus</td>
<td>Z_y</td>
<td>446.00</td>
<td>cm³</td>
</tr>
<tr>
<td>Plastic section modulus</td>
<td>Z_z</td>
<td>73.75</td>
<td>cm³</td>
</tr>
</tbody>
</table>

Cross-section properties IS 300/120/5/10, EN-AW 6005A

8.3 Classification

According to [1], Clause 6.3.3, NOTE 1 and NOTE 2, cross-sections with combined bending and longitudinal forces are to be classified separately for each load component. A cross-section can belong to different classes for shear force, bending about the major axis, and bending about the minor axis.

Slenderness parameters according to [1], Table 6.2

Buckling class BC for EN-AW 6005A: A (see [1], Table 3.2b)

Web - internal part

\[ \frac{\beta_{s1}}{\varepsilon_s} = 11 \quad \frac{\beta_{s2}}{\varepsilon_s} = 16 \quad \frac{\beta_{s3}}{\varepsilon_s} = 22 \]

Material properties for \( t_s = 5 \text{ mm} \)
\[ f_{o,s} = 225 \text{ MPa} \quad f_{u,s} = 270 \text{ MPa} \]

Material factor
\[ \varepsilon_s = \sqrt{\frac{250 / f_{o,s}}{250 / 225}} = 1.054 \]
Flange - outstand part

\[ \beta_{f,1} = 3 \quad \beta_{f,2} = 4.5 \quad \beta_{f,3} = 6 \]

Material properties for \( t_f = 10 \text{ mm} \)

\( f_{o,f} = 215 \text{ MPa} \quad f_{u,f} = 260 \text{ MPa} \)

Material factor

\[ \varepsilon_f = \sqrt{250 / f_{o,f}} = \sqrt{250 / 215} = 1.078 \]

Compressive force \( N_c \)

\[ \sigma_{N_c} = -\frac{16 \text{ kN}}{38 \text{ cm}^2} = -4.21 \text{ MPa} \]

Web - internal part

Slenderness parameter according to [1], Clause 6.1.4.3 a):
- flat internal parts with no stress gradient

\[ \beta_{w,Nc} = \frac{b_w}{t_w} = \frac{280}{5} = 56 \quad \text{Eq. (6.1)} \]

\[ \beta_{w,Nc} > \beta_{w,3} \]

\[ \beta_{w,Nc} > \frac{\beta_{w,3}}{\varepsilon_w} \cdot \varepsilon_w = 22 \cdot 1.054 = 23.19 \Rightarrow \text{Class 4} \]

Flange - outstand part

Slenderness parameters according to [1], Clause 6.1.4.3 a):
- flat outstands with no stress gradient

\[ \beta_{f,Nc} = \frac{b_f}{t_f} = \frac{57.5}{10} = 5.75 \quad \text{Eq. (6.1)} \]

\[ \beta_{f,Nc} \leq \beta_{f,3} \]

\[ \beta_{f,Nc} \leq \frac{\beta_{f,3}}{\varepsilon_f} \cdot \varepsilon_f = 6 \cdot 1.078 = 6.47 \Rightarrow \text{Class 3} \]

Bending moment \( M_y \) about major axis (y-y axis)

Web - internal part

Stresses at web edges

\[ \sigma_{s,A,M_y} = -18.78 \text{ MPa} \]

\[ \sigma_{s,B,M_y} = 18.78 \text{ MPa} \]

Stress ratio

\[ \psi_{s,M_y} = \frac{\sigma_{s,B,M_y}}{\sigma_{s,A,M_y}} = \frac{18.78}{-18.78} = -1.000 \]

Stress gradients

\[ \eta_{s,M_y} = 0.7 + 0.3 \psi_{s,M_y} = 0.7 + 0.3 \cdot -1.000 = 0.400 \quad \text{Eq. (6.4)} \]
Slenderness parameters according to [1], Clause 6.1.4.3 b):
- flat internal parts with a stress gradient that results in a neutral axis at the center

\[ \beta_{s,My} = \eta_{s,My} \frac{b_s}{t_s} = 0.400 \times \frac{280}{5} = 22.4 \]  
\[ \text{Eq. (6.2)} \]
\[ \beta_{s,My} \leq \beta_{s,3} \]
\[ \beta_{s,My} \leq \frac{\beta_{s,3}}{\xi_s} \cdot \varepsilon_s = 22 \cdot 1.054 = 23.19 \quad \Rightarrow \text{Class 3} \]

**Flange - outstand part**

Stresses at flange edges
- Root \( \sigma_{f,A,My} = -20.13 \text{ MPa} \)
- Toe \( \sigma_{f,B,My} = -20.13 \text{ MPa} \)

Stress ratio
\[ \psi_{f,My} = \frac{\sigma_{f,A,My}}{\sigma_{f,B,My}} = \frac{-20.13}{-20.13} = 1.000 \]

Slenderness parameters according to [1], Clause 6.1.4.3 a):
- flat outstands with no stress gradient

\[ \beta_{f,My} = \frac{b_f}{t_f} = \frac{57.5}{10} = 5.75 \]  
\[ \text{Eq. (6.1)} \]
\[ \beta_{f,NC} \leq \beta_{f,3} \]
\[ \beta_{f,NC} \leq \frac{\beta_{f,3}}{\xi_f} \cdot \varepsilon_f = 6 \cdot 1.078 = 6.47 \quad \Rightarrow \text{Class 3} \]

**Bending moment \( M_z \) about minor axis (z-z axis)**

**Web - internal part**

Stresses at web edges
- \( \sigma_{s,A,Mz} = \sigma_{s,B,Mz} = 0 \text{ MPa} \) \(
\Rightarrow \text{Web without compression} \)

**Flange - outstand part**

Stresses at flange edges
- Root \( \sigma_{f,A,Mz} = -1.73 \text{ MPa} \)
- Toe \( \sigma_{f,B,Mz} = -41.62 \text{ MPa} \)

Slenderness parameters according to [1], Clause 6.1.4.3 a):
- flat outstands with maximum compression at toe

\[ \beta_{f,Mz} = \frac{c_f}{t_f} = \frac{57.5}{10} = 5.75 \]  
\[ \text{Eq. (6.1)} \]
\[ \beta_{f,Mz} \leq \beta_{f,3} \]
\[ \beta_{f,Mz} \leq \frac{\beta_{f,3}}{\xi_f} \cdot \varepsilon_f = 6 \cdot 1.078 = 6.47 \quad \Rightarrow \text{Class 3} \]

**Governing: Class 4**
8.4 Effective Cross-Section Properties

Effective cross-sectional area: Class 4 for compressive force $N_c$.

**Web - internal part**

Buckling factor according to [1], Clause 6.1.5(2)

$$\rho_{c,s,Nc} = \frac{C_1}{(\beta_{s,Nc} / \varepsilon_s)} - \frac{C_2}{(\beta_{2,Nc} / \varepsilon_s)^2} = \frac{32}{56 / 1.054} - \frac{220}{(56 / 1.054)^2} = 0.524$$  \hspace{1cm} Eq. (6.12)

Effective web thickness

$$t_{c,s,Nc} = \rho_{c,s,Nc} \cdot t_w = 0.524 \cdot 5 = 2.622 \text{ mm}$$

Effective web area

$$A_{s,eff,Nc} = t_{c,s,Nc} \cdot b_s = 2.622 \cdot 280 = 734.16 \text{ mm}^2$$

**Flange - outstand part**

Class 3 - no reduction according to clause 6.1.5(2), Eq. (6.11)

$$\rho_{c,f,Nc} = 1.000$$

$$t_{c,f,Nc} = t_f = 10 \text{ mm}$$

Flange area

$$A_f = 2 \cdot A_{f,1} = 2 \cdot t_f \cdot c_f = 2 \cdot 10 \cdot 120 = 2400 \text{ mm}^2$$

Effective area of true section

$$A_{eff} = A_s + A_f = 734.16 + 2400 = 3134.16 \text{ mm}^2$$
8.5 Flexural Buckling About Major Axis (⊥ to y-y)

Elastic torsional-flexural buckling force according to [1], Annex I.3

\[ N_{cr,y} = \frac{\pi^2 E I_y}{L_{cr,y}^2} = \frac{\pi^2 \cdot 70000 \cdot 59626700}{4000^2} = 2574652 \text{ N} = 2574.65 \text{ kN} \]  

Eq. (I.15)

Relative slenderness for flexural buckling according to [1], Clause 6.3.1.2(1)

\[ \bar{\lambda}_y = \sqrt{\frac{A \cdot f_o}{N_{cr,y}}} = \sqrt{\frac{3800 \cdot 215}{2574652}} = 0.512 \]  

Eq. (6.51)

Limit of the horizontal plateau and imperfection factor according to [1], Table 6.6

Buckling class A \( \Rightarrow \alpha_y = 0.200 \)  \( \bar{\lambda}_{y,0} = 0.100 \)

Conditions for considering buckling effects according to [1], Clause 6.3.1.2(4)

\[ \bar{\lambda}_y > \bar{\lambda}_{y,0} \quad 0.512 > 0.100 \]

\[ N_{ed} > \bar{\lambda}_{y,0}^2 \cdot N_{cr,y} \quad 16 \cdot 0.010 \cdot 2574.65 = 25.746 \]

Check

\[ \eta_{Ncr,y} = \frac{N_{ed}}{\bar{\lambda}_{y,0}^2 \cdot N_{cr,y}} = \frac{16.00}{25.746} = 0.62 \]

After the second condition, it is not necessary to consider the flexural buckling about the y-axis.

Auxiliary factor according to clause 6.3.1.2(1)

\[ \phi_y = 0.5 \left[ 1 + \alpha_y \left( \bar{\lambda}_y - \bar{\lambda}_{y,0} \right) + \bar{\lambda}_y^2 \right] = 0.5 \left[ 1 + 0.2 \cdot (0.512 - 0.1) + 0.512^2 \right] = 0.672 \]  

Eq. (6.51)

Reduction factor according to clause 6.3.1.2(1)

\[ \chi_y = \frac{1}{\phi_y + \sqrt{\phi_y^2 - \bar{\lambda}_y^2}} = \frac{1}{0.672 + \sqrt{0.672^2 - 0.512^2}} = 0.903 \]  

Eq. (6.50)

Results of the RF-ALUMINIUM calculation

<table>
<thead>
<tr>
<th></th>
<th>( I_y )</th>
<th>5962.67</th>
<th>cm(^4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective member length</td>
<td>( L_{cr,y} )</td>
<td>4.000</td>
<td>m</td>
</tr>
<tr>
<td>Elastic flexural-buckling force</td>
<td>( N_{cr,y} )</td>
<td>2574.65</td>
<td>kN</td>
</tr>
<tr>
<td>Relative slenderness</td>
<td>( \bar{\lambda}_{trans,y} )</td>
<td>0.512</td>
<td>&gt; 0.1</td>
</tr>
<tr>
<td>Buckling class</td>
<td>Class</td>
<td>A</td>
<td>Tab. 3.2b</td>
</tr>
<tr>
<td>Imperfection factor</td>
<td>( \alpha_y )</td>
<td>0.200</td>
<td>Tab. 6.6</td>
</tr>
<tr>
<td>Auxiliary factor</td>
<td>( \phi_y )</td>
<td>0.672</td>
<td>Eq. (6.51)</td>
</tr>
<tr>
<td>Reduction factor</td>
<td>( \chi_y )</td>
<td>0.903</td>
<td>Eq. (6.50)</td>
</tr>
</tbody>
</table>
8.6 Flexural Buckling About Minor Axis (⊥ to z-z)

Elastic torsional-flexural buckling force according to [1], Annex I.3

\[ N_{cr,z} = \frac{\pi^2Ez}{L_{cr,z}^2} = \frac{\pi^2 \cdot 70000 \cdot 2882920}{4000^2} = 124483.1 \text{ N} = 124.483 \text{ kN} \]

Eq. (I.15)

Relative slenderness for flexural buckling according to [1], Clause 6.3.1.2(1)

\[ \tilde{\lambda}_z = \sqrt{\frac{\lambda \cdot f_0}{N_{cr,z}}} = \sqrt{\frac{3800 \cdot 215}{124483.1}} = 2.327 \]

Eq. (6.51)

Limit of the horizontal plateau and imperfection factor according to [1], Table 6.6

Buckling class A \( \Rightarrow \alpha_z = 0.200 \quad \tilde{\lambda}_{z,0} = 0.100 \)

Conditions for considering buckling effects according to [1], Clause 6.3.1.2(4)

\[ \tilde{\lambda}_z > \tilde{\lambda}_{z,0} \quad 2.327 > 0.100 \]

\[ N_{Ed} > \tilde{\lambda}_{z,0}^2 \cdot N_{cr,z} \quad 16 > 0.010 \cdot 124.483 = 1.245 \]

\( \Rightarrow \) A flexural buckling analysis is necessary.

Auxiliary factor according to [1], Clause 6.3.1.2(1)

\[ \phi_z = 0.5 \left[ 1 + \alpha_z \cdot \left( \tilde{\lambda}_z - \tilde{\lambda}_{z,0} \right) + \chi_z^2 - \chi_z \right] = 0.5 \left[ 1 + 0.2 \cdot (2.327 - 0.1) + 2.327^2 \right] = 3.429 \]

Eq. (6.51)

Reduction factor according to [1], Clause 6.3.1.2(1)

\[ \chi_z = \frac{1}{1 + \phi_z \sqrt{\lambda_z^2 - \tilde{\lambda}_z^2}} = \frac{1}{3.429 + \sqrt{3.429^2 - 2.327^2}} = 0.168 \]

Eq. (6.50)

Design factor of flexural buckling resistance according to [1], Clause 6.3.1.1(2)

\[ N_{b,Rd,z} = \kappa \cdot \chi_z \cdot A_{eff} \cdot \frac{f_0}{\gamma_{M1}} = 1.000 \cdot 0.168 \cdot 3134.1 \cdot 215 / 1.1 = 102982.3 \text{ N} = 102.98 \text{ kN} \]

Eq. (6.49)

There are no seam welds. Therefore, the following applies for the factor \( \kappa \) for taking into account the weakening by the weld seams: \( \kappa = 1.000 \)

Design ratio [1], Clause 6.3.1.1(1)

\[ \frac{N_{Ed}}{N_{b,Rd,z}} = \frac{16}{102.98} = 0.155 \]

Eq. (6.48)

Results of the RF-ALUMINIUM calculation

| Moment of Inertia | 2882.92 cm$^4$ |
| Effective member length | 4.000 m |
| Elastic flexural-buckling force | 124.48 kN |
| Relative slenderness | 2.327 |
| Buckling class | A |
| Imperfection factor | 0.200 |
| Auxiliary factor | 3.429 |
| Reduction factor | 0.168 |
8.7 Torsional Buckling About Longitudinal Axis (About x-x)

Elastic torsional buckling force according to [1], Annex I.3

\[
N_{cr,T} = \frac{1}{L^2} \left[ \frac{\pi^2 EI_{cr}}{L^2} \right]
\]

\[
N_{cr,T} = \frac{1}{128.257^2} \left[ 27000 \cdot 87883.6 + \frac{\pi^2 70000 \cdot 60552000000}{4000^2} \right] = 303191.1 \text{ N} = 303.191 \text{ kN}
\]

Relative slenderness for torsional buckling according to [1], Clause 6.3.1.4(2)

\[
\bar{\lambda}_T = \left( \frac{A_{eff} \cdot f_0}{N_{cr,T}} \right) = \sqrt{\frac{31341.215}{303191.1}} = 1.491
\]

Limit of the horizontal plateau, imperfection factor and effective cross-section area according to [1], Table 6.7

General cross-section shape \( \Rightarrow \bar{\lambda}_{T,0} = 0.400 \quad \alpha_T = 0.350 \quad \text{use } A_{eff} \)

According to [1], Clause 6.3.1.4(1), NOTE b), you can neglect the possibility of torsional buckling for doubly-symmetric I-sections.

\( \Rightarrow \) No torsional check is necessary.

8.8 Torsional-Flexural Buckling

**Elastic critical moment for lateral-torsional buckling**

The elastic critical moment for LTB \( M_{cr} \) is determined according to [1], Annex I.1 assuming a pinned support that is free to warp.

The point of load application is taken at the shear center. In the Details dialog box, you can adjust the point of load application for transverse loads (see Chapter 3.1.2, page 35).

For columns supported at both ends and that are free to warp, the effective length factor according to [1], Clause I.1.1(2) can be taken as the standard support:

\( k_y = 1.00 \quad k_z = 1.00 \quad k_w = 1.00 \)

In [1], Clause I.1.1(1), Eq. (I.1), you find the equation for determining the elastic critical moment for LTB of a beam, which is subject to a uniform in-plane bending moment through the shear center. The beam has a uniform, symmetric cross-section with equal flanges and a lateral and torsional restraint at both ends:

\[
M_{cr,0} = \frac{\pi^2 EI_z}{L^2} \cdot \frac{L^2 GI_x}{\pi^2 EI_z + I_{\alpha z}} = \frac{\sqrt{\pi^2 EI_z GI_x}}{L} \cdot \frac{1}{\sqrt{1 + \frac{\pi^2 EI_{\alpha z}}{L^2 GI_x}}}
\]

\[
M_{cr,0} = \frac{\pi \sqrt{70000 \cdot 288292 \cdot 27000 \cdot 87883.6}}{4000} \sqrt{1 + \frac{\pi^2 70000 \cdot 6.0552e+10}{4000^2 \cdot 27000 \cdot 87883.6}}
\]

\[
M_{cr,0} = 24916960 \text{ Nmm} = 24.916 \text{ kNm}
\]
According to [1], Clause I.1.2 and I.1.3, the elastic critical moment for LTB necessary for the slendernesses is determined as follows:

The values of the factors $C_{1.0}$ and $C_{1.1}$ are taken from [1], Table I.2 (row 1, uniform load):

$$C_{1.0} = 1.127 \quad C_{1.1} = 1.132$$

For equal flanges, the following applies: 

$$\psi = \frac{l_u - l_h}{l_u + l_h} = 0 \implies C_2 = 0.459 \quad \text{Eq. (I.4b)}$$

Dimensionless torsional parameter

$$\kappa_{wt} = \frac{\pi}{k_u L} \sqrt{\frac{E I_{L}}{G I_t}} = \frac{\pi}{1.400} \sqrt{\frac{70000 \cdot 6.0552e+10}{27000 \cdot 87883.6}} = 1.050$$

Factor $C_1$

$$C_1 = C_{1.0} + (C_{1.1} - C_{1.0}) \kappa_{wt} \leq C_{1.1}$$

$$C_1 = 1.127 + (1.132 - 1.127) \cdot 1.050 = 1.132$$

Relative dimensionless elastic critical moment for LTB at doubly-symmetric cross-section subjected to transverse load in shear center ($z_i = 0, z_g = 0$) according to [1], Clause I.1.3(2)

$$\kappa_{cr} = \frac{C_1}{k_u} \sqrt{1 + \kappa_{wt}^2} = \frac{1.132}{1.00} \sqrt{1 + 1.050^2} = 1.641 \quad \text{Eq. (I.8)}$$

Elastic critical moment for LTB according to [1], Clause I.1.2(2), Eq. (I.2)

$$M_{cr} = \kappa_{cr} \sqrt{\frac{E I_{z} G I_t}{L}} = 1.641 \sqrt{\frac{70000 \cdot 288292 \cdot 27000 \cdot 87883.6}{4000}}$$

$$M_{cr} = 28205999 \text{Nmm} = 28.21 \text{kNm}$$

The elastic critical moment for LTB used for determining slendernesses can also be determined according to the following rearranged equation:

$$M_{cr} = C_1 \frac{\pi^2 E I_{z}}{L^2} \sqrt{\frac{L^2 \cdot G I_t + I_{zo}}{\pi^2 E I_{z}}} = C_1 \frac{\sqrt{E I_{z} G I_t}}{L} \sqrt{1 + \frac{\pi^2 E I_{z}}{L^2 G I_t}}$$

$$M_{cr} = 1.132 \frac{\sqrt{70000 \cdot 288292 \cdot 27000 \cdot 87883.6}}{4000} \sqrt{1 + \frac{\pi^2 70000 \cdot 6.0552e+10}{4000^2 \cdot 27000 \cdot 87883.6}}$$

$$M_{cr} = 28205999 \text{Nmm} = 28.21 \text{kNm}$$

RF-ALUMINIUM also gives the maximum elastic critical moment for LTB $M_{cr,0}$, which is determined by assuming a uniform moment distribution.

**Please note:** For the results by $x$-location for simple bending about major axis and for sets of members, the values of $M_{cr,x}$ are also shown at each $x$-location. These are the elastic critical moments for LTB referring to the elastic critical moment for LTB at the location of the maximum moment. Then, the relative slenderness is determined by using $M_{cr,x} \sum_{LT}$. 

---

Program RF-ALUMINIUM © 2014 Dlubal Software GmbH
Slenderness ratio for lateral-torsional buckling

The calculation is carried out according to [1], Clause 6.3.2.3 or l.2 for the location of the maximum moment at \( x = 2.0 \, \text{m} \).

IS 300/150/4/8, cross-section class 3 for bending about y-y: \( W_y = W_{el,y} = 397.51 \, \text{cm}^3 \)

Shape factor \( \alpha \) according to [1], Table 6.4

\[ \alpha_{3,0} = 1 \]

Relative slenderness according to section 6.3.2.3(1), Eq. (6.58)

\[ \bar{\lambda}_{LT} = \frac{\alpha W_{el,y} f_y}{f_{0.1}} = \sqrt{\frac{1.39751 \cdot 215}{2820.6}} = 1.741 \]

Reduction factor \( \chi_{LT} \)

The calculation is carried out according to [1], Clause 6.3.2.2.

The buckling curve according to [1], Clause 6.3.2.2(2) depends on the cross-section class.

Class for \( M_y \): 3 \( \Rightarrow \) Buckling curve "2" \( \Rightarrow \) \( \bar{\lambda}_{0,LT} = 0.400 \)

\( \alpha_{LT} = 0.200 \)

Auxiliary factor according to [1], Clause 6.3.2.2(1)

\[ \phi_{LT} = 0.5 \cdot \left[ 1 + \alpha_{LT} \cdot \left( \bar{\lambda}_{LT} - \bar{\lambda}_{0,LT} \right) + \bar{\lambda}_{LT}^2 \right] = 0.5 \left[ 1 + 0.2 \cdot (1.741 - 0.4) + 1.741^2 \right] = 2.149 \]

Eq. (6.57)

Reduction factor according to [1], Clause 6.3.2.2(1)

\[ \chi_{LT} = \frac{1}{\phi_{LT} + \sqrt{\phi_{LT}^2 - \bar{\lambda}_{LT}^2}} = \frac{1}{2.149 + \sqrt{2.149^2 - 1.741^2}} = 0.293 \]

Eq. (6.56)

Design value of moment resistance according to [1], Clause 6.3.2.1(2)

\[ M_{b,ld} = \chi_{LT} \cdot \alpha \cdot W_{el,y} \cdot \frac{f_y}{f_{0.1}} = 0.293 \cdot 1.000 \cdot 397511 \cdot \frac{215}{1.10} = 22788229 \, \text{Nmm} = 22.79 \, \text{kNm} \]

8.9 Bending with Axial Compression

Interaction factors \( \xi_{yc}, \xi_{zc}, \eta_c \) and \( \gamma_c \)

The exponents of the interaction expressions are described in clause 6.3.3.1(1), Eq. (6.61a) through (6.61e). The standard recommends standard values but also allows for alternatives. In the example, the standard values are used. \( \gamma_c \) is given in clause 6.2.9.1(1), Eq. (6.42b).

\[ \eta_c = 0.80 \quad \xi_{yc} = 0.80 \quad \xi_{zc} = 0.80 \quad \gamma_c = \gamma_0 = 1.00 \]

HAZ factors \( \omega_0 \), \( \omega_c \) and \( \omega_{c,LT} \)

Because there are no local weld seams, the factors can be taken according to [1], Clause 6.2.9.1(1) as 1.00.

\[ \omega_0 = \omega_c = \omega_{c,LT} = 1.00 \]
8 Worked Example: Column Subject to Biaxial Bending

Design values of resistance $N_{Rd}$, $M_{y,Rd}$, $M_{z,Rd}$
The design values of resistance are determined according to [1], Clause 6.3.3.1(5) and 6.3.3.2(1).

$$N_{Rd} = \gamma \cdot A_{eff} \cdot f_{o} = 1.000 \cdot 3134.1 \cdot \frac{215}{1.10} = 612583 \text{ N} = 612.583 \text{ kN}$$

Shape factor $\alpha$ according to [1], Table 6.4

$$\alpha_{3,u} = 1$$

Design value of moment resistance about y-axis

$$M_{y,Rd} = \alpha_{y} \cdot W_{y,el} \cdot f_{o} = 1.000 \cdot 77695332 \text{ Nmm} = 77.695 \text{ kNm}$$

Design value of moment resistance about z-axis

$$M_{z,Rd} = \alpha_{z} \cdot W_{z,el} \cdot f_{o} = 1.000 \cdot 9391317 \text{ Nmm} = 9.391 \text{ kN}$$

**Flexural buckling according to [1], Clause 6.3.3.1**

Interaction for flexural buckling about major axis and bending moment $M_{y}$

$$\left( \frac{N_{Ed}}{\chi_{y} \cdot \omega_{x,y} \cdot N_{Rd}} \right)^{\gamma_{yc}} + \frac{M_{y,Ed}}{\omega_{o} \cdot \gamma_{y,Rd}} \leq 1.00$$

Eq. (6.59)

$$\left( \frac{16}{0.903 \cdot 1.00 \cdot 612583} \right)^{0.8} + \frac{8}{1.00 \cdot 77.695} \leq 1.00$$

$$0.059 + 0.103 = 0.162 \leq 1.00$$

Interaction for flexural buckling about minor axis and bending moment $M_{z}$

$$\left( \frac{N_{Ed}}{\chi_{z} \cdot \omega_{x,z} \cdot N_{Rd}} \right)^{\gamma_{z}} + \frac{M_{z,Ed}}{\omega_{o} \cdot \gamma_{z,Rd}} \leq 1.00$$

Eq. (6.60)

$$\left( \frac{16}{0.168 \cdot 1.00 \cdot 612583} \right)^{0.8} + \frac{2}{1.00 \cdot 9.391} \leq 1.00$$

$$0.225 + 0.29 = 0.516 \leq 1.00$$

**Torsional-flexural buckling according to [1], Clause 6.3.3.2**

$$\left( \frac{N_{Ed}}{\chi_{z} \cdot \omega_{x,z} \cdot N_{Rd}} \right)^{\gamma_{z}} + \left( \frac{M_{y,Ed}}{\chi_{LT} \cdot \omega_{xLT} \cdot M_{y,Rd}} \right)^{\gamma_{yc}} + \left( \frac{M_{z,Ed}}{\omega_{o} \cdot \gamma_{z,Rd}} \right)^{\gamma_{z}} \leq 1.00$$

Eq. (6.63)

$$\left( \frac{16}{0.168 \cdot 1.00 \cdot 612583} \right)^{0.8} + \left( \frac{0.293 \cdot 1.00 \cdot 77.695}{1.00 \cdot 9.391} \right)^{1.0} + \left( \frac{2}{1.00 \cdot 9.391} \right)^{0.8} \leq 1.00$$

$$0.225 + 0.351 + 0.29 = 0.867 \leq 1.00$$

**Note:** In Eq. (6.59) and (6.60) for flexural buckling, $\chi_{y}$ and $\chi_{z}$ are the reduction factors for buckling in the z-x or y-x plane.

In Eq. (6.63) for torsional-flexural buckling, $\chi_{z}$ is the reduction factor for buckling, if one of the two flanges shows lateral deflection (buckling in x-y plane or flexural-torsional buckling).
### Results of the RF-ALUMINIUM calculation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Unit</th>
<th>Equation/Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elastic critical moment for torsional buckling $N_{cr,T}$</td>
<td>303.19</td>
<td>kN</td>
<td>Eq. (I.16)</td>
</tr>
<tr>
<td>Modulus of elasticity $E$</td>
<td>7000.0</td>
<td>kN/cm²</td>
<td>3.2.5(1)</td>
</tr>
<tr>
<td>Second moment of area $I_y$</td>
<td>59626700</td>
<td>mm⁴</td>
<td></td>
</tr>
<tr>
<td>Effective member length $L_{cr,y}$</td>
<td>4000.0</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Elastic flexural buckling force $N_{cr,y}$</td>
<td>2574.65</td>
<td>kN</td>
<td>Eq. (I.14)</td>
</tr>
<tr>
<td>Second moment of area $I_z$</td>
<td>2882920</td>
<td>mm⁴</td>
<td></td>
</tr>
<tr>
<td>Effective member length $L_{cr,z}$</td>
<td>4000.0</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Elastic flexural buckling force $N_{cr,z}$</td>
<td>124.48</td>
<td>kN</td>
<td>Eq. (I.15)</td>
</tr>
<tr>
<td>Relative slenderness $\lambda_{z}$</td>
<td>&gt; 2.327</td>
<td></td>
<td>6.3.1.2(4)</td>
</tr>
<tr>
<td>Buckling curve $BC_z$</td>
<td>1</td>
<td></td>
<td>Tab. 6.6</td>
</tr>
<tr>
<td>Imperfection factor $\alpha_z$</td>
<td>0.200</td>
<td></td>
<td>Tab. 6.6</td>
</tr>
<tr>
<td>Auxiliary factor $\phi_z$</td>
<td>3.429</td>
<td></td>
<td>6.3.1.2(1)</td>
</tr>
<tr>
<td>Reduction factor $\zeta_z$</td>
<td>0.168</td>
<td></td>
<td>Eq. (6.50)</td>
</tr>
<tr>
<td>Cross-sectional area $A$</td>
<td>3800.0</td>
<td>mm²</td>
<td></td>
</tr>
<tr>
<td>Characteristic proof strength $f_a$</td>
<td>21.50</td>
<td>kN/cm²</td>
<td>Tab. 3.2.1</td>
</tr>
<tr>
<td>Buckling curve $BC_{LT}$</td>
<td>2</td>
<td></td>
<td>6.3.2.2(2)</td>
</tr>
<tr>
<td>Imperfection factor $\alpha_{LT}$</td>
<td>0.200</td>
<td></td>
<td>6.3.2.2(2)</td>
</tr>
<tr>
<td>Shear modulus $G$</td>
<td>2700.0</td>
<td>kN/cm²</td>
<td>3.2.5(1)</td>
</tr>
<tr>
<td>Effective length factor $k_z$</td>
<td>1.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effective length factor $k_w$</td>
<td>1.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length $L$</td>
<td>4000.0</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Warping constant of cross-section $I_w$</td>
<td>6.0552E+10</td>
<td>mm⁶</td>
<td></td>
</tr>
<tr>
<td>Torsional constant $J$</td>
<td>87883.6</td>
<td>mm⁴</td>
<td></td>
</tr>
<tr>
<td>Elastic critical moment for LTB $M_{cr,0}$</td>
<td>24.92</td>
<td>kNm</td>
<td></td>
</tr>
<tr>
<td>Elastic critical moment for LTB $M_{cr}$</td>
<td>28.19</td>
<td>kNm</td>
<td></td>
</tr>
<tr>
<td>Moment $C_1$</td>
<td>1.131</td>
<td></td>
<td>Eigenvalue solution</td>
</tr>
<tr>
<td>Modulus of cross-section $S_y$</td>
<td>397511</td>
<td>mm³</td>
<td></td>
</tr>
<tr>
<td>Relative slenderness $\lambda_{LT}$</td>
<td>1.741</td>
<td></td>
<td>6.3.2.3</td>
</tr>
<tr>
<td>Auxiliary factor $\phi_{LT}$</td>
<td>2.150</td>
<td></td>
<td>6.3.2.2(1)</td>
</tr>
<tr>
<td>Reduction factor $\zeta_{LT}$</td>
<td>0.293</td>
<td></td>
<td>Eq. (6.56)</td>
</tr>
<tr>
<td>Elastic critical load for torsional buckling $N_{cr,T}$</td>
<td>303.19</td>
<td>kN</td>
<td>Eq. (I.16)</td>
</tr>
<tr>
<td>Axial force (compression) $N_{Ed}$</td>
<td>16.00</td>
<td>kN</td>
<td></td>
</tr>
<tr>
<td>Factor for section with localized weld $\omega_{xy}$</td>
<td>1.000</td>
<td></td>
<td>6.3.3</td>
</tr>
<tr>
<td>Factor for section with localized weld $\omega_{xz}$</td>
<td>1.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exponent $\xi_{yc}$</td>
<td>0.800</td>
<td></td>
<td>6.3.3</td>
</tr>
<tr>
<td>Exponent $\xi_{zc}$</td>
<td>0.800</td>
<td></td>
<td>6.3.3</td>
</tr>
</tbody>
</table>
### 8 Worked Example: Column Subject to Biaxial Bending

<table>
<thead>
<tr>
<th>Factor for section with localized weld</th>
<th>( \omega_0 )</th>
<th>1.000</th>
<th>6.2.9, 6.3.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>HAZ factor</td>
<td>( \omega_{LT} )</td>
<td>1.000</td>
<td>6.3.3</td>
</tr>
<tr>
<td>Exponent</td>
<td>( \omega_c )</td>
<td>1.000</td>
<td>6.3.3</td>
</tr>
<tr>
<td>Exponent</td>
<td>( \eta_c )</td>
<td>0.800</td>
<td>6.3.3</td>
</tr>
<tr>
<td>Governing cross-sectional area</td>
<td>( A_{\text{eff}} )</td>
<td>3134.15 mm²</td>
<td></td>
</tr>
<tr>
<td>Axial force resistance</td>
<td>( N_{\text{nd}} )</td>
<td>612.58 kN</td>
<td>Eq. (6.22)</td>
</tr>
<tr>
<td>Partial safety factor</td>
<td>( \gamma_M )</td>
<td>1.100</td>
<td>Tab. 6.1</td>
</tr>
<tr>
<td>Design component for ( N )</td>
<td>( \eta_{Nv} )</td>
<td>0.054 &lt; 1</td>
<td>Eq. (6.59)</td>
</tr>
<tr>
<td>Design component for ( N )</td>
<td>( \eta_{Nu} )</td>
<td>0.225 &lt; 1</td>
<td>Eq. (6.60)</td>
</tr>
<tr>
<td>Moment</td>
<td>( M_{j,Ed} )</td>
<td>8.00 kNm</td>
<td></td>
</tr>
<tr>
<td>Moment</td>
<td>( \Delta M_{j,Ed} )</td>
<td>0.00 kNm</td>
<td></td>
</tr>
<tr>
<td>Modulus of cross-section</td>
<td>( S_y )</td>
<td>397511 mm³</td>
<td></td>
</tr>
<tr>
<td>Moment resistance</td>
<td>( M_{j,Ed} )</td>
<td>77.70 kNm</td>
<td></td>
</tr>
<tr>
<td>Moment component</td>
<td>( \eta M_y )</td>
<td>0.35 &lt; 1</td>
<td></td>
</tr>
<tr>
<td>Moment</td>
<td>( M_{k,Ed} )</td>
<td>2.00 kNm</td>
<td></td>
</tr>
<tr>
<td>Moment</td>
<td>( \Delta M_{k,Ed} )</td>
<td>0.00 kNm</td>
<td></td>
</tr>
<tr>
<td>Modulus of cross-section</td>
<td>( W_z )</td>
<td>48048.6 mm³</td>
<td></td>
</tr>
<tr>
<td>Moment resistance</td>
<td>( M_{k,Ed} )</td>
<td>9.39 kNm</td>
<td></td>
</tr>
<tr>
<td>Moment component</td>
<td>( \eta_{Mz} )</td>
<td>0.290 &lt; 1</td>
<td></td>
</tr>
<tr>
<td>Design 1</td>
<td>( \eta_1 )</td>
<td>0.157 &lt; 1</td>
<td>Eq. (6.59)</td>
</tr>
<tr>
<td>Design 2</td>
<td>( \eta_2 )</td>
<td>0.516 &lt; 1</td>
<td>Eq. (6.60)</td>
</tr>
<tr>
<td>Design 3</td>
<td>( \eta_3 )</td>
<td>0.867 &lt; 1</td>
<td>Eq. (6.63)</td>
</tr>
<tr>
<td>Check</td>
<td>( \eta )</td>
<td>0.867 &lt; 1</td>
<td></td>
</tr>
</tbody>
</table>
A Literature


# B Index

## A

- Accidental ............................................................... 11
- Alloy ........................................................................ 23
- Alternative values .................................................... 33
- Amplification factor ................................................... 35
- Angle section ............................................................ 34
- Axis ........................................................................ 22, 26

## B

- Background graphic ..................................................... 53
- Beam type .................................................................. 32
- Browsing through windows .......................................... 8
- Buckling ..................................................................... 25
- Buckling length .......................................................... 24
- Butt .......................................................................... 23
- Buttons ....................................................................... 52

## C

- Calculation .................................................................. 33
- Cantilever ................................................................... 21, 32
- Characteristic ............................................................. 12
- Classification ............................................................... 34
- Clipboard .................................................................... 65
- Closed cross-section .................................................... 40
- Color bar ..................................................................... 52
- Color spectrum ............................................................ 56
- Colored diagram ........................................................ 56
- Comment ....................................................................... 9
- Control panel ............................................................... 56
- Cross-section .............................................................. 16, 34, 62
- Cross-section check ...................................................... 44
- Cross-section class ....................................................... 33
- Cross-section database ................................................ 39
- Cross-section library .................................................... 16
- Cross-section optimization ........................................... 62
- Cross-section type ....................................................... 18

## D

- Decimal places ............................................................ 14, 64
- Deflection ..................................................................... 12
- Deformation analysis ................................................... 32
- Design .......................................................................... 9, 18, 42, 43, 44
- Design case ................................................................. 54, 60, 61
- Design ratio ................................................................. 43
- Design situation .......................................................... 11, 12, 44
- Detail settings .............................................................. 33
- Display navigator ......................................................... 54, 56
- Distance x ................................................................... 36

## E

- Effective length .......................................................... 24, 26, 28, 65
- Effective length factor ................................................... 26
- Elastic critical moment for LT8 ....................................... 35
- Equivalent member length ............................................ 24
- Evaluation of results ..................................................... 52
- Excel ........................................................................... 66
- Exit RF-ALUMINIUM .................................................... 8
- Export .......................................................................... 65
- Export cross-section ..................................................... 63
- Export effective length .................................................. 65
- Export material ............................................................ 65

## F

- Favorite ........................................................................ 62
- Fillet ............................................................................ 23
- Filter ............................................................................ 52, 56
- Filter members .............................................................. 57
- Flexural buckling .......................................................... 21, 25, 35
- Frequent ........................................................................ 12

## G

- General data ............................................................... 8
- Graphic ......................................................................... 53
- Graphic printout .......................................................... 58

## H

- HAZ ........................................................................ 17
- Heat path ...................................................................... 23
- Heat-affected zone ......................................................... 22, 34
- Hidden result diagram .................................................. 56

## I

- Info about cross-section ............................................... 19
- Installation .................................................................... 6
- Intermediate lateral restraint ........................................ 21
- Internal forces ............................................................... 47, 63

## L

- Lateral and torsional restraint ......................................... 21, 26, 27
- Lateral restraint ............................................................ 21
- Lateral-torsional buckling ............................................... 21, 26
- Length .......................................................................... 24, 50
## B Index

Limit deformation ................................................. 38  
Limit values ......................................................... 9, 12, 13, 36  
List of members ..................................................... 32  
Load application .................................................... 36  
Load case .......................................................... 10, 12, 47  
Load combination .................................................. 10  
Location x .......................................................... 43  
LTB length .......................................................... 27  

**M**  
Material .......................................................... 14, 23, 65  
Material description ................................................ 15  
Material library ..................................................... 15  
Material properties ................................................. 14  
Member end release ............................................... 31  
Member slendernesses ............................................ 39, 49  
Member-like input .................................................. 28, 36  
Members ............................................................. 9  
Method .............................................................. 23  
MIG ................................................................. 23  

**N**  
National Annex ................................................... 9, 13  
Navigator ............................................................ 8  
Nodal support ....................................................... 29  

**O**  
Open module ........................................................ 6  
OpenOffice .......................................................... 66  
Optimization ......................................................... 18, 39, 62, 63  

**P**  
Panel ............................................................... 7, 54, 56  
Parametric section ................................................ 62  
Part ................................................................. 50  
Partial safety factors .............................................. 13  
Parts list ............................................................ 50, 51  
Persistent ........................................................... 11  
Plate girder .......................................................... 34  
Precamber ........................................................... 32  
Print ................................................................. 58  
Printout report ..................................................... 58, 59  
Product form ....................................................... 15  

**Q**  
Quasi-permanent .................................................. 12  

**R**  
Reference length .................................................. 12  
Relatively ........................................................... 21, 22  
Remark ............................................................... 18  
Rendering ........................................................... 56  
Result combination ............................................... 10, 11, 52  
Result diagram ..................................................... 55, 58  
Result values ....................................................... 53  
Result windows ..................................................... 42  
Results display ..................................................... 54  
RFEM graphic ....................................................... 58  
RFEM work window ............................................... 53  
RF-STABILITY ....................................................... 25  

**S**  
Second-order effects .............................................. 35  
Serviceability ...................................................... 32, 38  
Serviceability limit state ......................................... 12, 52  
Set of members ..................................................... 9, 28, 29, 31, 32, 36, 45, 48, 51  
SHAPE-THIN ....................................................... 34  
SHAPE-THIN section .............................................. 17, 39  
Shifted member ends .............................................. 38  
Slenderness ........................................................ 37, 49  
Special cases ....................................................... 36  
Stability ............................................................ 35  
Stability analysis .................................................. 21, 44  
Start calculation ................................................... 41  
Start RF-ALUMINIUM .............................................. 6  
Stress point ........................................................ 19  
Sum ................................................................. 51  
Surface area ....................................................... 50  

**T**  
Tapered member .................................................... 18  
Temperature ........................................................ 23  
TIG ................................................................. 23  
Torsion ............................................................. 37  
Torsional buckling ................................................ 37  
Torsional length .................................................. 27  
Torsional-flexural buckling ...................................... 21, 37  
Transient ........................................................... 11  
Transverse load .................................................... 36  
Transverse weld .................................................... 22, 34  
Triaxial state of stress ........................................... 13  

**U**  
Ultimate limit state ............................................... 10, 33, 52  
Undeformed initial system ...................................... 38  
Units ................................................................. 14, 64  
User profile ....................................................... 64
# Index

**V**
- View mode ........................................... 53
- Visibilities ........................................... 56
- Volume .............................................. 51

**W**
- Warping length factor .................................. 27
- Warping restraint ...................................... 27

**Weight** .......................................................... 51
**Weld seam** .................................................... 17, 22
**Weld type** ..................................................... 23
**WEZ** .......................................................... 22
**Window** ....................................................... 8

**X**
- x-location .................................................. 43, 47